Note: This manual L025317 is intended for use only with the following D-Series laser coder models:
D120i, D120i IP,
D120i Blue, D120i Blue IP,
D320i, D320i IP,
D320i Blue, D320i Blue IP,
D320i Red, D320i Red IP,
D520i, D520i IP,
D620i, D620i IP,
D620i Blue, D620i Blue IP
WARNINGS: 

(1) As supplied, this coder is a class 4 laser product. During operation, it will emit up to 120 watts of pulsed invisible laser radiation at a wavelength between 9 and 11 microns. Avoid eye or skin exposure to direct or scattered radiation.

(2) This coder must be fitted with class 1 laser guarding to safeguard against accidental exposure to direct or scattered radiation before it is operated or made ready for use.

(3) Guidance on creating and fitting laser guarding can be found in part 1 of the product manual.

(4) Use of controls or adjustments of performance or procedures other than those specified in this manual may result in hazardous radiation exposure.

(5) The laser print head (D120 ip, D320 ip) is cooled by compressed air. Air overpressure inside the laser print head is harmful and may lead to rupture of the cabinet.

(6) The maximum pressure for the compressed air supplied into the print head is 4 bar. A pressure supply of 4 bar must not be exceeded at any time.

(7) The laser print head has two air outlets. Both air outlets must be kept clear as blocked air outlets can cause an overpressure inside the cabinet and may lead to rupture (potential hazard). Please do not swap air inlet and outlet.

(8) The length of the compressed air outlet hose must not exceed 4 metres.
DOMINO D-SERIES LASER CODER

WARNING: This is a Class 4 Laser using high power invisible infrared light. A risk of personal injury or damage to equipment may result if proper safety precautions are not observed. Reading and understanding this manual is required before operating this laser system.

This manual, Domino Part No. L025317, has been produced for use in the maintenance and operation of the Domino D-Series Laser Coder, and to reinforce and complement any training program available with the product. It is not designed to replace any such training program.

All rights reserved. No part of this publication may be reproduced, stored on a retrieval system, or transmitted in any form, or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior permission of Domino Printing Sciences plc.

Domino Printing Sciences plc has a policy of continuous product improvement. The Company, therefore, reserves the right to modify the specification contained in this manual without notice.

For sales and service assistance please visit the following website and select “Contact Domino in your country” for local technical support:

http://www.domino-printing.com

Domino Printing Sciences plc

Bar Hill
Cambridge
CB23 8TU
United Kingdom
Tel: +44 1954 782551
Fax: +44 1954 782874

© Domino Printing Sciences plc 2014
EC DECLARATION OF CONFORMITY
(in accordance with ISO/IEC 17050-1)

No. L025317/4

Issuer's name: Domino Laser GmbH, Germany

Issuer's Address: Fangdieckstrasse 75a, 22547 Hamburg / Germany

Object of the declaration: D-Series laser marking system consisting of: BCP7 controller, laser head and optional TouchPanel.

The object of the declaration described above is in conformity with the requirements of the following documents:

EN 61000-6-2:2005 Electromagnetic compatibility (EMC) - Part 6-2: Generic standards - Immunity for industrial environments.


EN 61326-1:2006 Electrical equipment for measurement, control and laboratory use - EMC requirements - Part 1: General requirements (IEC 61326-1:2005)

EN 61010-1: 2010 Chapter 11 and 13 Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: General requirements

EN ISO 13849-1:2008 Safety of machinery - Safety related parts of control systems - Part 1

2006/95/EC: Low Voltage Directive
2011/65/EU: RoHS2 Directive

Additional Information
Compliance is dependent upon installation and use in accordance with the Product Manual supplied.

Signed for and on behalf of
Domino Laser GmbH, Fangdieckstrasse 75a, 22547 Hamburg / Germany
July 2014

[Signature]

Dr. Wilhelm Specker
Research & Development Director - Domino Laser GmbH
CONTENTS OF THE
EC DECLARATION OF CONFORMITY
(in accordance with ISO/IEC 17050-1)

No.  L025317/4
Issuer's name:  Domino Laser GmbH, Germany
Issuer's Address:  Fangdieckstrasse 75a, 22547 Hamburg / Germany
Object of the declaration:  D-Series laser marking system consisting of:
BCP7 controller, laser head and optional TouchPanel.
The object of the declaration described above is in conformity
with the requirements of the following documents:

EN 61000-6-2:2005 Electromagnetic compatibility (EMC) - Part 6-2: Generic standards - Immunity for industrial environments.


EN 61326-1:2006 Electrical equipment for measurement, control and laboratory use - EMC requirements - Part 1: General requirements (IEC 61326-1:2005)

EN 61010-1: 2010 Chapter 11 and 13 Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: General requirements

EN ISO 13849-1:2008 Safety of machinery - Safety related parts of control systems - Part 1

2006/95/EC: Low Voltage Directive
2011/65/EU: RoHS2 Directive

Additional Information
Compliance is dependent upon installation and use in accordance with the Product Manual supplied.
EU DECLARATION OF INCORPORATION

(in accordance to the Directive 2006/42/EC on Machinery appendix II 1.B for partly completed machines)

No. L025317/4

Issuer's Name: Domino Laser GmbH

Issuer's Address: Fangdieckstrasse 75a, 22547 Hamburg, Germany,

Person authorised to compile the relevant technical documentation, who must be established in the Community
Research & Development Department, Domino Laser GmbH

Object of the declaration: D-Series laser marking system consisting of:
BCP7 controller, laser head and optional TouchPanel.

The special technical documents corresponding to the machine have been created according to Appendix VII, part B.

It is expressly stated that the partly completed machine fulfills all the relevant provisions of the following EC directives.


2006/95/EU Directive 2006/95/EC of the European parliament and of the Council of 12 December 2006 on the harmonisation of the laws of Member States relating to electrical equipment designed for use within certain voltage limits


Published applied harmonized standards according to Article 7 (2)


EN 61326-1:2006  Electrical equipment for measurement, control and laboratory use - EMC requirements - Part 1: General requirements (IEC 61326-1:2005)

EN 61010-1: 2010  Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: General requirements

EN ISO 13849-1:2008  Safety of machinery - Safety related parts of control systems - Part 1

Published other applied technical standards and specifications


We commit to transmit, in response to a reasoned request by the surveillance authorities, relevant documents on the partly completed machinery. Property rights of the manufacturer of the partly completed machinery remain unaffected.

Important Note

The partly completed machinery must not be put into service until the final machinery into which it is to be incorporated has been declared in conformity with the provisions of this Directive, where appropriate:

Hamburg, July 2014

Dr. Wilhelm Specker
Research & Development Director
Domino Laser GmbH
CONTENTS OF THE EU DECLARATION OF INCORPORATION

(in accordance to the Directive 2006/42/EC on Machinery appendix II I.B for partly completed machines)

No. L025317/4
Issuer's Name: Domino Laser GmbH
Issuer's Address: Fangdieckstrasse 75a, 22547 Hamburg, Germany,

Person authorised to compile the relevant technical documentation, who must be established in the Community
Research & Development Department, Domino Laser GmbH

Object of the declaration: D-Series laser marking system consisting of: BCP7 controller, laser head and optional TouchPanel.

The special technical documents corresponding to the machine have been created according to Appendix VII, part B.

It is expressly stated that the partly completed machine fulfills all the relevant provisions of the following EC directives.


2006/95/EU Directive 2006/95/EC of the European parliament and of the Council of 12 December 2006 on the harmonisation of the laws of Member States relating to electrical equipment designed for use within certain voltage limits


Published applied harmonized standards according to Article 7 (2)

EN 61000-6-2:2005 Electromagnetic compatibility (EMC) - Part 6-2: Generic standards - Immunity for industrial environments.
EN 61326-1:2006 Electrical equipment for measurement, control and laboratory use - EMC requirements - Part 1: General requirements (IEC 61326-1:2005)
EN 61010-1: 2010 Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: General requirements
EN ISO 13849-1:2008 Safety of machinery - Safety related parts of control systems - Part 1

Published other applied technical standards and specifications


We commit to transmit, in response to a reasoned request by the surveillance authorities, relevant documents on the partly completed machinery. Property rights of the manufacturer of the partly completed machinery remain unaffected.

Important Note

The partly completed machinery must not be put into service until the final machinery into which it is to be incorporated has been declared in conformity with the provisions of this Directive, where appropriate;
CERTIFICATION

Laser Controller D320i (BCP7) & Laser Controller D320i IP (BCP7)
Approved by Certificate No.: CU72110452 01

Laser Controller D620i (BCP7) & Laser Controller D620i IP (BCP7)
Approved by Certificate No.: CU72110452 02

Industrial laser for marking
D120i; D120i IP; D120i BLUE; D120i BLUE IP; D320i; D320i IP; D320i BLUE; D320i BLUE IP; D520i; D520i IP; D620i; D620i IP
Approved by Certificate No.: CU72112124 01

Industrial laser for marking
D320i RED; D320i RED IP
Approved by Certificate No.: CU72112124 02

Industrial laser for marking
D620i BLUE; D620i BLUE IP
Approved by Certificate No.: CU72112124 03
FCC NOTICE

PART 18 USERS MANUAL STATEMENT

This equipment has been tested and found to comply with the limits of ISM Equipment pursuant to Part 18 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a typical installation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communication. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re-orientate or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
• Consult the dealer or an experienced radio/TV technician for help.

Any changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.
MICROSOFT’S EMBEDDED SYSTEMS END USER LICENSE AGREEMENT (“EULA”)

- You have acquired a device (“DEVICE”) that includes software licensed by Domino Printing Sciences plc from Microsoft Licensing Inc. or its affiliates (“MS”). Those installed software products of MS origin, as well as associated media, printed materials, and “online” or electronic documentation (“SOFTWARE”) are protected by international intellectual property laws and treaties. The SOFTWARE is licensed, not sold. All rights reserved.

- IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO NOT USE THE DEVICE OR COPY THE SOFTWARE. INSTEAD, PROMPTLY CONTACT DOMINO PRINTING SCIENCES PLC FOR INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT).

GRANT OF SOFTWARE LICENSE. This EULA grants you the following license:

- You may use the SOFTWARE only on the DEVICE

- NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. DOMINO PRINTING SCIENCES PLC HAS INDEPENDENTLY DETERMINED HOW TO USE THE SOFTWARE IN THE DEVICE, AND MS HAS RELIED UPON DOMINO PRINTING SCIENCES PLC TO CONDUCT SUFFICIENT TESTING TO DETERMINE THAT THE SOFTWARE IS SUITABLE FOR SUCH USE.

- NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided “AS IS” and with all faults. THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF NEGLIGENCE) IS WITH YOU. ALSO, THERE IS NO WARRANTY AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST INFRINGEMENT. IF YOU HAVE RECEIVED ANY WARRANTIES REGARDING THE DEVICE OR THE SOFTWARE, THOSE WARRANTIES DO NOT ORIGINATE FROM, AND ARE NOT BINDING ON, MS.
• **Note on Java Support.** The SOFTWARE may contain support for programs written in Java. Java technology is not fault tolerant and is not designed, manufactured, or intended for use or resale as online control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of Java technology could lead directly to death, personal injury, or severe physical or environmental damage. Sun Microsystems, Inc. has contractually obligated MS to make this disclaimer.

• **No Liability for Certain Damages.** EXCEPT AS PROHIBITED BY LAW, MS SHALL HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THE SOFTWARE. THIS LIMITATION SHALL APPLY EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. IN NO EVENT SHALL MS BE LIABLE FOR ANY AMOUNT IN EXCESS OF U.S. TWO HUNDRED FIFTY DOLLARS (U.S.$250.00).

• **Limitations on Reverse Engineering, Decompilation, and Disassembly.** You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

• **SOFTWARE TRANSFER ALLOWED BUT WITH RESTRICTIONS.** You may permanently transfer rights under this EULA only as part of a permanent sale or transfer of the Device, and only if the recipient agrees to this EULA. If the SOFTWARE is an upgrade, any transfer must also include all prior versions of the SOFTWARE.

**EXPORT RESTRICTIONS.** You acknowledge that SOFTWARE is of US-origin. You agree to comply with all applicable international and national laws that apply to the SOFTWARE, including the U.S. Export Administration Regulations, as well as end-user, end-use and country destination restrictions issued by U.S. and other governments. For additional information on exporting the SOFTWARE, see http://www.microsoft.com/exporting/.

© 2000 Microsoft Corporation. All rights reserved. Terms of use.
LICENCE NOTES FOR DYNAMARK 3

Dynamark 3 uses code of the following projects:

- STLport (http://stlport.sourceforge.net)
- Boost (http://www.boost.org)
- libSigC++ (http://libsigc.sourceforge.net)
- FreeType (http://www.freetype.org)
- zlib (http://www.zlib.net)
- dxflib (http://www.ribbonsoft.com/de/about-dxflib)
- SQLite (http://www.sqlite.org)
- Lua (http://www.lua.org)
- FreeImage (http://freeimage.sourceforge.net)
LIABILITIES AND WARRANTIES

Warranty and liability rights for personal or material damages are precluded, if they are caused by one of the following:

- Non-designated use of the laser marking system.
- The use of consumer-electronics (e.g. PDAs or Mobiles) as user interface for the marking laser systems is not recommended nor supported.
- Unauthorized installation or configuration of software on the controller.
- Unauthorized execution or configuration of programs on operating system level. On integration of the laser marking system into a TCP / IP network the Domino Laser GmbH excludes liability for all damages that are caused by attacks on the controller (like viruses, worms). The laser marking systems are built for integration in a secure industry network.
- Improper installation, commissioning, operating, and maintaining of the laser marking system.
- Operating the equipment with defective safety installations, or improperly installed or inoperable safety and protective devices.
- Non-compliance with the instructions of the operating manual regarding transport, storage, installation, commissioning, repairs, or maintenance of the laser marking system.
- Opening the laser unit.
- Unauthorised structural modifications to the laser marking system.
- Unauthorised modifications of the beam and laser parameters.
- Inadequate monitoring of components. (Refer to PART 5 MAINTENANCE AND FAULT FINDING)
- Disasters, war, and acts of God.
CONTENTS

PART 1 HEALTH & SAFETY

PART 2 INSTALLATION INSTRUCTIONS

PART 3 OPERATION

PART 4 TECHNICAL REFERENCE

PART 5 MAINTENANCE AND FAULT FINDING

APPENDIX A  MARKING FONTS

APPENDIX B  BARCODES
# AMENDMENT RECORD

<table>
<thead>
<tr>
<th>Amendment</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Parts at Issue 1</td>
<td>November 2010</td>
</tr>
<tr>
<td>All Parts at Issue 2</td>
<td>May 2011</td>
</tr>
<tr>
<td>All Parts at Issue 3</td>
<td>August 2012</td>
</tr>
<tr>
<td>All Parts at Issue 4</td>
<td>June 2013</td>
</tr>
<tr>
<td>All Parts at Issue 5</td>
<td>July 2014</td>
</tr>
</tbody>
</table>
# PART 1 : HEALTH & SAFETY

## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GENERAL</td>
<td>1-3</td>
</tr>
<tr>
<td>DESIGNATED USE</td>
<td>1-4</td>
</tr>
<tr>
<td>SAFETY SYMBOLS</td>
<td>1-6</td>
</tr>
<tr>
<td>SPECIFIC DANGERS</td>
<td>1-7</td>
</tr>
<tr>
<td>Electrical Energy</td>
<td>1-7</td>
</tr>
<tr>
<td>Compressed Air</td>
<td>1-7</td>
</tr>
<tr>
<td>Water Cooling</td>
<td>1-7</td>
</tr>
<tr>
<td>Laser Radiation</td>
<td>1-8</td>
</tr>
<tr>
<td>Harmful Dusts and Vapours</td>
<td>1-9</td>
</tr>
<tr>
<td>Lenses</td>
<td>1-9</td>
</tr>
<tr>
<td>Scan Head Mirrors</td>
<td>1-9</td>
</tr>
<tr>
<td>Noise</td>
<td>1-10</td>
</tr>
<tr>
<td>Crushing</td>
<td>1-10</td>
</tr>
<tr>
<td>Laser Marking Process</td>
<td>1-10</td>
</tr>
<tr>
<td>GUARDING</td>
<td>1-11</td>
</tr>
<tr>
<td>Access Guards</td>
<td>1-11</td>
</tr>
<tr>
<td>Visor Guards</td>
<td>1-11</td>
</tr>
<tr>
<td>Beam Stop Guard</td>
<td>1-12</td>
</tr>
<tr>
<td>Materials</td>
<td>1-12</td>
</tr>
<tr>
<td>Interlock Switches</td>
<td>1-13</td>
</tr>
<tr>
<td>Emergency Off</td>
<td>1-13</td>
</tr>
<tr>
<td>Guarding Labels</td>
<td>1-13</td>
</tr>
<tr>
<td>Specific Precautions During Maintenance or Repair Work</td>
<td>1-14</td>
</tr>
<tr>
<td>SYSTEM NAMING CONVENTIONS</td>
<td>1-15</td>
</tr>
<tr>
<td>Complete system (laser and controller)</td>
<td>1-15</td>
</tr>
<tr>
<td>Laser</td>
<td>1-16</td>
</tr>
<tr>
<td>Controller</td>
<td>1-17</td>
</tr>
<tr>
<td>LASER WARNING AND INFORMATION SIGNS</td>
<td>1-18</td>
</tr>
<tr>
<td>Technical data (D)</td>
<td>1-19</td>
</tr>
<tr>
<td>Location of Controller signs</td>
<td>1-20</td>
</tr>
<tr>
<td>Controller rear side (E)</td>
<td>1-20</td>
</tr>
<tr>
<td>Location of Laser signs</td>
<td>1-21</td>
</tr>
</tbody>
</table>
GENERAL

The D-Series laser marking systems are designed and built in accordance with international standards and other technical specifications, which are to be observed. The equipment conforms to current technology and approved safety requirements.

Domino D-Series Laser marking systems are produced by Domino Laser GmbH Germany. For Sales and support contact Domino.

This safety standard, however, can only be achieved if all intended and required measures have been taken and are constantly observed. It is part of the operator’s duties to plan these measures and check their continuing implementation.

The D-Series laser marking systems have been developed and designed for fully automated marking of packaging materials and products by use of laser radiation.

The user must ensure that:

- The laser system is only made ready for use after it has been installed and guarded to Class 1 laser safety standards (EN60825), see “HEALTH & SAFETY” on page 1-1.
- The equipment is only to be used for its intended purpose, see “DESIGNATED USE” on page 1-4.
- The equipment is only operated in a good, serviceable condition, and that all safety installations are regularly checked for their serviceability.
- Personal protective goggles for maintenance and repair personnel are required and made available.
- Only suitable and approved tools and equipment are used.
- This Product Manual is complete and in a legible condition at the equipment location at all times.
- The valid rules and laws regarding accident prevention are available and observed.
- Only sufficiently qualified and authorised personnel shall operate, maintain, and repair the laser marking system.
- These personnel are regularly instructed in all matters concerning appropriate labour safety and environmental protection, and that they are familiar with the operating manual, particularly the safety instructions contained herein.
- Any safety and warning signs on the laser marking system must not be removed and must remain in a readable condition.
DESIGNATED USE

The D-Series laser marking system is exclusively designated for fully automated marking of packaging materials and products by laser radiation.

If the laser marking system is used for improper purposes, all liability claims will be refused.

The technical specifications listed in “TECHNICAL REFERENCE” Part 4 must be observed and complied with at all times.

The manufacturer will not be liable for any material or personal damages resulting from non-designated usage.

The laser marking system must only be operated by authorised and specifically trained personnel who are familiar with and observe the procedures within this manual.

It is strongly recommended to carry out a risk assessment regarding laser printer integration according to EN ISO13849 and EN ISO11553. Potential hazards resulting from laser material processing machines are reported in EN ISO11553 including hazards from laser material processing (e.g. dusts, emissions, fires or explosion) and other potential hazards.
Before turning the laser equipment on, check and ensure that:

- The laser system has been installed and guarded to Class 1 laser safety standards (EN60825), see “HEALTH & SAFETY” on page 1-1
- Only authorised personnel should be present within the operating area of the laser marking system.

For IP-rated print heads with compressed air cooling only, check and ensure that:

- The compressed air supplied to the printhead does not exceed a pressure of 4 bar.
- Both air outlets are kept clear.
- Air inlet and outlet are fitted correctly.

Before starting any production

- Check the laser marking system for any visible damage. Ensure that it is only operated in “best possible” condition. Discovered defects must be eliminated immediately.
- Check and ensure that material or other objects not required for the production are removed from the operating area of the laser marking system.
- Check and ensure the flawless functioning of all safety devices.

All valid rules and laws for accident prevention are to be observed.
SAFETY SYMBOLS

In this manual, the following safety symbols have been used to alert the reader to the text of the safety instruction next to it.

This manual provides specific safety instructions for the operation of the laser marking system. These instructions exist for:

- Personnel
- Products and machines
- The environment.

**WARNING:** Indicates danger to life and health if the instructions are not observed.

**CAUTION:** Indicates a risk of material damage if the instructions are not observed.

**WARNING:** Indicates a danger from harmful dusts and vapours.

**WARNING:** Indicates a danger from dangerous laser radiation.

**WARNING:** Indicates a danger from dangerous electrical voltage.
HEALTH & SAFETY

SPECIFIC DANGERS

Electrical Energy

In the D-Series laser marking system, the maximum operating voltage is the connected mains voltage, which can pose a hazard to health. The mains voltage to be maintained is shown on the name plate.

Work on live components must only be performed by authorised personnel.

In the case of a defective power supply, operation of the laser marking system is to be stopped immediately and is only to be repaired by authorised personnel.

Keep the control unit closed at all times. Only expressly authorised personnel are permitted to open the control unit.

Compressed Air

The laser print head is cooled by compressed air (D120i IP65, D320i IP65). Air overpressure inside the laser print head is harmful and may lead to rupture of the cabinet.

The maximum pressure for the compressed air supplied into the print head is 4 bar. A pressure supply of 4 bar must not be exceeded at any time. The compressed air has to be free of oil, Class 1.7.2 of ISO8573.

The laser print head has two air outlets. Both air outlets must be kept clear as blocked air outlets can cause an overpressure inside the cabinet and may lead to rupture (potential hazard). Please do not swap air inlet and outlet.

The outer diameter of the outlet hose must be 12 mm. The length of the compressed air outlet hose must not exceed 4 metres!

Note: Contact Domino before disconnecting the silencer or connecting a hose to the air outlet 2 at the laser. If two hoses are used for the compressed air outlet these have to be placed in different positions for safety reasons. One event must not block both hoses.

Water Cooling

Handle the glycol based coolant with care. For more details see the safety data sheet of the coolant.

As a guide, avoid skin contact with the coolant. Always wear protective gloves and safety goggles when working with the coolant.

In case of:

- skin contact - remove the coolant by washing with water.
- eye contact - remove by washing with water and seek medical help immediately.
- swallowing - seek medical help immediately.
Refer to the specific Safety Data Sheet supplied with the coolant for further information.

Only a water cooler with an empty tank is allowed to be shipped. Refer to the Water Chiller manual for the procedure to empty the tank.

**Laser Radiation**

Laser radiation can pose a risk to eyes and skin. The danger is not only posed by direct laser radiation, but also by scattered radiation and reflections from the work piece or the packaging machine. The degree of injury depends on the duration of the effect, the power and the wavelength of the laser.

Lasers and their installations are classified into seven laser protection classes, depending on their potential danger. Class 1 is the safest and Class 4 is potentially the most harmful. These classes are defined in detail in EN60825 Part 1 and are summarised below:

- **Class 1** The accessible laser radiation may be visible or invisible and is harmless.
- **Class 1M** The accessible laser radiation may be visible or invisible and is harmless, provided additional optical instruments are not used.
- **Class 2** The accessible laser radiation is visible and is harmless for accidental exposure to eyes for periods of less than 0.25 seconds.
- **Class 2M** The accessible laser radiation is visible and is harmless for accidental exposure to eyes for periods of less than 0.25 seconds, provided additional optical instruments are not used.
- **Class 3R** The accessible laser radiation may be visible or invisible. It is potentially harmful to eyes.
- **Class 3B** The accessible laser radiation may be visible or invisible. Direct radiation is harmful to the eyes and skin although diffuse radiation (reflected from a matt surface) is harmless.
- **Class 4** The accessible laser radiation may be visible or invisible. Direct and diffuse radiation is extremely harmful to eyes and skin and can pose a fire risk if projected onto combustible materials.

The D-Series laser marking systems, taken by themselves, are Class 4 and must not be used until suitable, interlocked guarding is fitted to achieve a Class 1 laser installation that physically prevents access to the laser radiation or automatically disables the laser when access is required to the marking area (for cleaning or maintenance, etc.).
Harmful Dusts and Vapours

When radiating materials by means of a laser, harmful dusts and vapours can be produced. The user is responsible for appropriate measures, e.g. an exhaust system, to reduce such harmful dusts and vapours to a level that complies with the allowed maximum concentration of pollutants at the workplace.

Lenses

Germanium and Zinc Selenide lenses are used in the D-Series laser system. Lenses must not be touched.

If the lens has been soiled, it must be thoroughly cleaned (see “CLEANING THE LENS” on page 5-3) before any operation.

The lens is not water resistant and must therefore only be cleaned with Isopropyl Alcohol. Dry the lens using cotton swabs (Q-tips), ensuring the surface of the lens is not scratched.

The lens has to be protected with a cover against splash water when cleaning the system.

Scan Head Mirrors

Never touch the mirrors of the scan head.

The mirrors are inside the scan head and there is a small risk of touching them when cleaning the lens.

The mirrors for the i-Tech 15 scan head are made of Beryllium.

When the mirrors have been touched accidentally wash hands thoroughly with water and soap.

Fumes and dust from Beryllium metal can be hazardous if inhaled.

Carefully clean the mirrors if they have been accidentally touched.
Noise
All systems emit during operation a noise level lower than 80dB(A), Therefore no personal protective equipment against noise is needed.

Crushing
There is a crushing hazard during installation and operation due to:
- Product moving along the laser head.
- Products moving into and out of protective housing.
- Doors and maintenance openings of protective housings.
Especially prevent the risk of squeezing.

Laser Marking Process
Potential fire risks could result from examples as listed below. This list is not considered to be complete. Local conditions must be considered as well.
- Printing on not specified material (e.g. easily inflammable or explosive materials).
- Invalid parameter settings (e.g. very low mark speed).
- Invalid parameter settings due to corrupted print data.
- Printing constantly on the same product (e.g. no product movement caused by various reasons).
- Inflammable gases or materials inside the working area.
In printing mode the laser beam is controlled by software which must be considered as part of the risk assessment.

*Note:* Install a fire detector near the laser to monitor the marking process.
GUARDING

The following type of guarding, using the recommended materials and construction techniques, is required to achieve a safe installation.

WARNING: Never install a laser in such a way that the lens points to a door or in the direction of an operator.

Access Guards

Access guards are required to prevent direct human access to the laser beam. In practice, this requires full guarding of the area between, and including, the laser output lens and the area to be marked on the substrate.

Note: Guarding is required behind the substrate to prevent access to the laser beam when the substrate is removed, or following accidental burn through of the substrate.

Visor Guards

Visor guards are required to prevent the escape of scattered radiation. Often the access guarding can be designed to perform this function without the need of an extra guard.

WARNING: Visor guards have to be installed at a minimum distance of four times the focus distance to the laser beam.
Beam Stop Guard

A beam stop guard is required for applications where guarding material is fitted within 100mm of the laser lens focal plane. The beam stop is to prevent burn through of the guard should the laser be repeatedly operated without the substrate in position. The beam stop must be capable of absorbing the full output power of the laser for a period of eight hours and be large enough to cover the complete laser marking field area.

Materials

All guard materials must be opaque to 9 to 11 micron wavelength laser light produced by the CO₂ laser. Guards may be metallic, however if a see-through guard is required Makrolon® 099 from Bayer AG may be used.

A metallic guard with low reflectivity must be used. The housing must be orientated in a way that no laser light is reflected back to the laser as the reflected light may damage the laser.

The thickness of the guard material depends on the mechanical strength required for stable housings, and the amount of ‘burn through’ anticipated. For the purpose of adequate mechanical rigidity and laser safety, a thickness of at least six millimetres for 10W 30W laser systems and a thickness of at least eight millimetres for 60W laser systems is recommended. To ensure laser safety a greater thickness of the guard material may be required.

Housings made from Makrolon® 099 must be installed within a minimum distance of the laser lens of:

- 4 times the focus distance for 10W and 30W systems.
- 5 times the focus distance for 60W systems.

These distances are important to eliminate mirror reflection from any surrounding parts.

In a fault condition, these materials withstand the laser beam for a limited time before the beam burns through. The laser must therefore be monitored to avoid a risk of fire.

A ceramic or metal plate may be used as a beam stop. A greater thickness is required to achieve an “eight hour burn through” requirement.

Guidance regarding laser guards can be found in EN60825-Part 4.
Interlock Switches

Interlock switches must be fitted to all access guards preventing access to the laser output lens and marking area that can be opened without the use of access tools.

Interlock switches must be wired into the laser control circuit so that the laser beam is disabled when the guard is removed.

Emergency Off

Integrate the laser into the emergency off circuit of the machine into which the laser is integrated. Install an emergency off push button near the laser marking systems which turns off the laser. Connect the emergency off push button via the interlock circuit to the controller.

Guarding Labels

Domino recommend that the following information is prominently displayed on the guard:

WARNING: Class 4 laser is enclosed in a Class 1 enclosure. Operation of the system with safety guards removed may result in hazardous exposure to laser radiation.

These labels are supplied with the laser system. Additional labels are available from Domino Printing Sciences plc as part of the Guarding Labels Kit, Part Number L007628.
Specific Precautions During Maintenance or Repair Work

D-Series laser marking systems are Class 4.

In order to eliminate any danger to the operators, and in accordance with the conditions of laser protection Class 1, the laser beam must always be kept inside suitable guarding.

During maintenance or checks, laser radiation dangerous to persons can become directly accessible. Persons within the dangerous work area must undertake protective measures. Of particular importance is:

- Always wear protective goggles approved in the user's country whilst working
- Never look directly into the Laser beam (not even, when wearing protective goggles)
- Never expose skin to laser radiation
- Never insert flammable materials into the radiation beam

Laser protective goggles, approved for the respective intended purpose can be ordered from Domino (pt. No. L007761).
SYSTEM NAMING CONVENTIONS

Complete system (laser and controller)

Examples:

**D120i 10 STANDARD BCP7**
10W laser head, 10.6μm, **i-Tech** 10mm scan head, fan cooled, standard BCP7 controller

**D120i 10 BLUE IP65 STANDARD BCP7**
10W laser head, 9.3μm, **i-Tech** 10mm scan head, IP65, compressed air cooled, standard BCP7 controller

**D320i 10 BLUE IP65 IP55 BCP7**
30W laser head, 9.3μm, **i-Tech** 10mm scan head, IP65, compressed air cooled, IP55 BCP7 controller

**D320i 10 BLUE IP65 STANDARD BCP7**
30W laser head, 9.3μm, **i-Tech** 10mm scan head, IP65, compressed air cooled, standard BCP7 controller

**D320i 10 RED IP65 STANDARD BCP7**
30W laser head, 10.2μm, **i-Tech** 10mm scan head, IP65, compressed air cooled, standard BCP7 controller

**D620i 10 IP65 STANDARD BCP7**
60W laser head, 10.6μm, **i-Tech** 10mm scan head, water cooled, standard BCP7 controller
D120i
10W laser head, i-Tech scan head, 10.6μm, fan cooled

D120i IP
10W laser head, i-Tech scan head, 10.6μm, IP65, compressed air cooled

D120i BLUE
10W Laser head, i-Tech scan head, 9.3μm, fan cooled

D120i BLUE IP
10W Laser head, i-Tech scan head, 9.3μm, IP65, compressed air cooled

D320i
30W laser head, i-Tech scan head, 10.6μm, fan cooled

D320i IP
30W laser head, i-Tech scan head, 10.6μm, IP65, compressed air cooled

D320i BLUE
30W Laser head, i-Tech scan head, 9.3μm, fan cooled

D320i BLUE IP
30W Laser head, i-Tech scan head 9.3μm, IP65, compressed air cooled

D320i RED
30W Laser head, i-Tech scan head, 10.2μm, fan cooled

D320i RED IP
30W Laser head, i-Tech scan head, 10.2μm, compressed air cooled

D520i
55W laser head, i-Tech scan head, 10.6μm, fan cooled
D520i IP
55W laser head, **i-Tech** scan head, 10.6μm, IP65, water cooled

D620i
60W laser head, **i-Tech** scan head, 10.6μm, fan cooled

D620i IP
60W laser head, **i-Tech** scan head, 10.6μm, IP65, water cooled

D620i BLUE
60W Laser head, **i-Tech** scan head, 9.3μm, fan cooled

D620i BLUE IP
60W Laser head, **i-Tech** scan head 9.3μm, IP65, water cooled

---

**Controller**

```
D X YY i XX

D- Series
Product Family
3 = 10, 30 Watt laser
6 = 60 Watt laser
20 = second
controller generation
i = i-Tech

= IP43
IP = IP55
```

D320i
10W or 30W laser, IP43 controller

D320i IP
10W or 30W laser, IP55 controller

D620i
55W or 60W laser, IP43 controller

D620i IP
55W or 60W laser, IP55 controller
LASER WARNING AND INFORMATION SIGNS

Warning signs are located at specific points on the laser marking system. They correspond to the afore mentioned standards and specify the potential hazards and the required safety measures.

These warnings, additional information signs and their locations on the laser marking system are shown in the following illustrations.

Check their presence and readability regularly.

Laser warning sign (A)

Laser class 4 warning label (B)

Radiation from output lens (C)
Technical data (D)

Technical data for D120i Blue and D120i Blue IP

\[ P_0 = 30 \text{ W} \]
\[ \lambda = 9.3 \text{ } \mu\text{m} \]

Technical data for D120i and D120i IP

\[ P_0 = 30 \text{ W} \]
\[ \lambda = 10.6 \text{ } \mu\text{m} \]

Technical data for D320i Blue and D320i Blue IP

\[ P_0 = 75 \text{ W} \]
\[ \lambda = 9.3 \text{ } \mu\text{m} \]

Technical data for D320i and D320i IP

\[ P_0 = 75 \text{ W} \]
\[ \lambda = 10.6 \text{ } \mu\text{m} \]

Technical data for D320i Red and D320i Red IP

\[ P_0 = 75 \text{ W} \]
\[ \lambda = 10.2 \text{ } \mu\text{m} \]

Technical data for D620i Blue and D620i Blue IP

\[ P_0 = 120 \text{ W} \]
\[ \lambda = 9.3 \text{ } \mu\text{m} \]

Technical data for D620i and D620i IP

\[ P_0 = 120 \text{ W} \]
\[ \lambda = 10.6 \text{ } \mu\text{m} \]

Controller branding (example) (E)
Location of Controller signs
Controller rear side (E)
Location of Laser signs

D-Series
10 and 30 Watt heads
# PART 2 : INSTALLATION INSTRUCTIONS

## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNPACKING AND INVENTORY</td>
<td>2-3</td>
</tr>
<tr>
<td>ASSEMBLY</td>
<td>2-3</td>
</tr>
<tr>
<td>Environmental and Storage Conditions</td>
<td>2-3</td>
</tr>
<tr>
<td>Handling the Equipment</td>
<td>2-3</td>
</tr>
<tr>
<td>Laser Head Assembly</td>
<td>2-4</td>
</tr>
<tr>
<td>Scanner Fields and Distances</td>
<td>2-5</td>
</tr>
<tr>
<td>Removal of the transport locking device</td>
<td>2-6</td>
</tr>
<tr>
<td>Control Unit</td>
<td>2-7</td>
</tr>
<tr>
<td>Power supply</td>
<td>2-7</td>
</tr>
<tr>
<td>Installing the Main Cable: Controller to Laser</td>
<td>2-8</td>
</tr>
<tr>
<td>TOUCHPANEL INSTALLATION</td>
<td>2-11</td>
</tr>
<tr>
<td>ELECTRICAL CONNECTIONS</td>
<td>2-13</td>
</tr>
<tr>
<td>Connecting Laser Head Cable to X11</td>
<td>2-15</td>
</tr>
<tr>
<td>USB 1.1 Port</td>
<td>2-15</td>
</tr>
<tr>
<td>Ethernet connections</td>
<td>2-15</td>
</tr>
<tr>
<td>X2 Connector Schematic - Beacons</td>
<td>2-16</td>
</tr>
<tr>
<td>X3 Connector Schematic - Product Detector</td>
<td>2-18</td>
</tr>
<tr>
<td>X6 Connector Schematic - Shaft Encoder</td>
<td>2-18</td>
</tr>
<tr>
<td>X4 Connector Schematic - Machine Control</td>
<td>2-20</td>
</tr>
<tr>
<td>The Compile OK Signal</td>
<td>2-23</td>
</tr>
<tr>
<td>X7 Connector Schematic - Fume Extraction</td>
<td>2-26</td>
</tr>
<tr>
<td>X23 Connector Schematic - RS232 COM1</td>
<td>2-28</td>
</tr>
<tr>
<td>X28 Connector Schematic - Air Chiller Control</td>
<td>2-30</td>
</tr>
<tr>
<td>X58 Connector Schematic - Power Extension</td>
<td>2-32</td>
</tr>
<tr>
<td>X59 Connector Schematic - Ethernet 2 - Remote Panel Interface</td>
<td>2-33</td>
</tr>
<tr>
<td>SAFETY OF THE LASER SYSTEM</td>
<td>2-35</td>
</tr>
<tr>
<td>X29 Connector</td>
<td>2-36</td>
</tr>
<tr>
<td>Timing</td>
<td>2-38</td>
</tr>
<tr>
<td>Typical installation faults</td>
<td>2-39</td>
</tr>
<tr>
<td>CONNECTOR OVERVIEW</td>
<td>2-40</td>
</tr>
<tr>
<td>COMPRESSED AIR CONNECTION, LENS</td>
<td>2-41</td>
</tr>
<tr>
<td>COMPRESSED AIR CONNECTION</td>
<td>2-42</td>
</tr>
<tr>
<td>COOLING D120i IP D320i IP</td>
<td>2-42</td>
</tr>
</tbody>
</table>
Connection of Compressed Air to the Laser .......... 2-43
AIR FLOW SETTINGS ................................................................. 2-44
Air Flow without Air Chiller .................................................. 2-44
  D120i ............................................................................. 2-44
  D320i ............................................................................. 2-45
Air Flow without Air Chiller .................................................. 2-46
  D120i ............................................................................. 2-46
  D320i ............................................................................. 2-47
COOLING THE i-TECH 15 SCAN HEAD ......................... 2-48
  Air Flow Settings for the i-Tech 15 Scan Head .......... 2-49
WATER COOLING D620i ......................................................... 2-50
FUME EXTRACTION SYSTEM ............................................... 2-51
GUARDING ........................................................................... 2-52
INITIAL OPERATION ............................................................... 2-52
INITIAL SETUP WIZARD ....................................................... 2-53
POSITIONING CODE ON THE PRODUCT ..................... 2-54
  Achieving Maximum Line Speed ................................. 2-56
  Making marks longer than one field size ...................... 2-59
  RapidScan Technology ...................................................... 2-59
  Product Distance and Print Start - Ignore Distance ....... 2-61
UNPACKING AND INVENTORY

Prior to and while unpacking the control unit and laser assembly, visually check for damage that has occurred during transportation, in particular; loose parts, dents, scratches and missing parts.

ASSEMBLY

CAUTION: The assembly, i.e. the mounting and the installation of the laser marking system must only be performed by personnel qualified for this task and in accordance with the valid regulations and safety instructions.

Before assembly, check the laser head and control unit for visible damage. Refer to PART 1: “HEALTH & SAFETY”.

The installation of the laser marking system has to comply to IEC 60825-1.

Environmental and Storage Conditions

The following conditions are necessary for operation and storage of the laser marking system:

- Temperature +5°C to +40°C
- 90% max relative humidity - non-condensing

The controller is capable of operating within the International Protection Code IP43, which provides dust protection and protection from splashing water. To protect the installation from more severe conditions, extra measures must be taken.

CAUTION: To ensure IP43 protection always close the USB connection with the cap supplied.

Handling the Equipment

The equipment must be handled appropriately and carefully. The laser head must not be held by the scanner head or by the supply lines. The control unit is to be specifically protected during assembly.
Laser Head Assembly

The laser head must be mounted correctly on the support profile provided for this purpose (depending on the laser system used).

A mechanical de-coupler must be provided to prevent damage to the laser head, or its mounting, during shock or shaking motions of the packaging machine.

The lens opening must be centred vertically over the text field of the object to be marked.

Correct laser marking is only possible when the surface of the object is at the focal point of the lens.

The working distance is measured from the lower surface of the scanner to the top surface of the marking product.
Scanner Fields and Distances

### i-tech 10mm Scanner

<table>
<thead>
<tr>
<th>Focal Length</th>
<th>Maximum Field</th>
<th>Usable Field</th>
<th>Working Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>+/- 32</td>
<td>+/- 29</td>
<td>70</td>
</tr>
<tr>
<td>100</td>
<td>+/- 38</td>
<td>+/- 34</td>
<td>90</td>
</tr>
<tr>
<td>120</td>
<td>+/- 47</td>
<td>+/- 42</td>
<td>108</td>
</tr>
<tr>
<td>150</td>
<td>+/- 56.5</td>
<td>+/- 51</td>
<td>138</td>
</tr>
<tr>
<td>200</td>
<td>+/- 75.5</td>
<td>+/- 68</td>
<td>187</td>
</tr>
<tr>
<td>250</td>
<td>+/- 99.5</td>
<td>+/- 90</td>
<td>243</td>
</tr>
</tbody>
</table>

### i-tech 15mm Scanner

<table>
<thead>
<tr>
<th>Focal Length</th>
<th>Maximum Field</th>
<th>Usable Field</th>
<th>Working Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>270 x 260</td>
<td>200 x 254</td>
<td>246</td>
</tr>
<tr>
<td>325</td>
<td>360 x 344</td>
<td>262 x 334</td>
<td>326</td>
</tr>
<tr>
<td>450</td>
<td>485 x 467</td>
<td>356 x 452</td>
<td>427</td>
</tr>
</tbody>
</table>

All values in millimetres.
All values may fluctuate up to 5%.
The marking field of the i-Tech 15 scanner is rectangular and not a square. The orientation is shown in the graphic below.

Notes: (1) For mark on the fly installations, orientate the field such that the long field side (X-axis is in the same orientation as the product direction.

(2) RapidScan orientations are not available for the i-Tech 15 scanner.

Removal of the transport locking device

⚠️ CAUTION: The beam output lens is protected by a transport locking and dust protection cap to prevent damage or external soiling that will cause a reduction in laser performance. Remove this device without fail before operation.
Control Unit

CAUTION: Do not expose the control unit to any vibrations.

The control unit must be installed on a stable base.
The control unit has three internal blow-out fuses.
The operation voltage is 90V to 264V at 47Hz to 63Hz.

Two fuses (F1 and F2) for the input AC power
- F1 for the protected phase and
- F2 for the neutral line.

Fuse F3 protects the neutral line of the safety relay.

Note: The phase line of the safety relay is protected internally by the laser power supply unit.

The control unit needs at least 80mm free space on all sides for proper ventilation.

Power supply

The mains supply is provided by a 5m mains cable, which is connected to the control unit via a four-pole plug. It may be necessary to install a suitable AC mains plug to the loose end of the cable, connected as follows:

Green/Yellow  Ground/Earth
Black 2       Neutral
Black 1       Live

The equipment specifications, listed on the name plate (voltage, frequency, power consumption) are to be observed under all circumstances. The correct fusing is to be made external to the laser system.

The mains power connection must always be easily accessible during operation in order to quickly remove the power from the laser system when required.

The control unit contains the electrical components necessary for distribution of the correct voltages to the laser head.

The mains power AC line needs to be fused by
- a 16A fuse at 230V operating voltage,
- a 20A at 110V operating voltage.

Use a quick fuse or a circuit beaker characteristic B/C.

Connecting the protective earth of the laser marking system to the packaging machine earth rail prevents a ground loop.
Installing the Main Cable: Controller to Laser

Controller front view without main cable

Main cable with IP seal

Open the controller and insert the main cable into the controller
Lock the flange

Overview

View to the main cable connectors inside the controller front
Cable management for the 20 pin IDC connector

Cable management for the power connector

Close the controller cabinet. Controller with main cable fitted
TOUCHPANEL INSTALLATION

The installation must be carried out by trained technicians only.

Two supply voltages are provided for the TouchPanel which can be operated individually or in parallel:

- **Mains supply via the main socket.** Only use the Domino power cord: A free accessible power socket must be installed nearby the TouchPanel. Extension cables must not be used to connect the TouchPanel to mains power. The built-in power supply may be switched via the AC On/Off switch of the TouchPanel.

- **Power supply via the X59 ethernet connector of the BCP7 controller:** Only use the Domino X59 cables with 5m (Domino part number L015211) or 10m (Domino part number L015212) length to connect the TouchPanel to the BCP7 controller. Only these cables ensure the 24V DC power supply of the TouchPanel. The power supply of the TouchPanel fused with 2.5A inside the BCP7 controller. This power supply may only switched off with the BCP7 controller On/Off switch.
Disconnect the mains power in the event of TouchPanel failure. Ensure that both the Mains and BCP7 connection is removed.

The power supply to the internal power supply of the TouchPanel depends on if

- a BCP7 controller is connected via Ethernet to the TouchPanel and/or
- the AC mains supply of the TouchPanel is used.

Both power connections may be used in parallel.
ELECTRICAL CONNECTIONS

The following cables are part of the delivered package:

- Mains connection cable
- Connector plug to the machine control (X4) Type: 12-pole cable socket, solder connection, strain relief PG11
- USB and Ethernet Connections
- Connector plugs for X23, X59, X7, X28, X3, X6, X4, X2, X29, X58

Control Unit Electrical Connections

- X23: RS232 COM1
- X59: Ethernet 2: Remote Panel Interface (pre-configured 192.168.57.2, 255.255.255.0)
- USB: USB 1.1 Port
- Ethernet: Ethernet Connection (192.168.58.2, 255.255.255.0)
- X7: Fume Extractor
- X28: Air / Chiller Control
- X3: Photocell/Product Detector
- X6: Quadrature Shaft Encoder
- X4: Machine Control
- X2: Beacons
- X29: Interlock
- X58: Power Extension
**Note:** To prevent incorrect connections, different male and female connectors have been installed and clearly marked (X...). When connecting the cables, ensure that plugs are correctly aligned to prevent damage to the pins.

Connections for **D620i**

The lower controller cabinets contains the laser power supplies for the 60 W laser.

- **X12**  
  Safety Extension 1 - do not disconnect the factory fitted connector to X58

- **X11**  
  Safety Extension 2 - do not connect anything here
Connecting Laser Head Cable to X11

The flange socket (X11) on the laser head is located on the front panel. If the groove on the flange socket is not properly aligned, the cable should be turned, not the plug. Twists in the cable are to be avoided by properly routing the cable.

USB 1.1 Port

The USB 1.1 ports are located on the top right hand side of the front of the control unit.

Ethernet connections

There are two Ethernet connections. Ethernet 1 connection is pre-configured for access via the IP address 192.168.58.2 / subnet mask 255.255.255.0. The connector is a RJ45 Bulgin connector. Ethernet 2 connection (X59) is pre-configured for plug and play connection of the optional Touchpanel. The IP address is 192.168.57.2 / subnet mask 255.255.255.0.
X2 Connector Schematic - Beacons
The D-Series laser marking system offers a DC beacon interface for 24V Domino standard beacons with 4 colours.

Connector Type:
- IEC 60130-9 Type 5 way female

Mating Cable Connector (IP67 Types):
- Lumberg: 033205-1

**Pin description**
- Pin 1 BLUE - Blue Lamp +24V Output
- Pin 2 AMBER - Amber Lamp +24V Output
- Pin 3 GREEN - Green Lamp +24V Output
- Pin 4 RED - Red Lamp +24V Output
- Pin 5 GND - Floating Ground

**Outputs**
Voltage: 24V floating, max. current 170 mA
The beacon indicators are in a solid state as described below:
- Green - printer is printing or ready to print.
- Red - there is a fault, printer has stopped.
- Amber - printer requires attention - a warning is displayed but printer is printing.
- Blue - software loaded - printer is not ready
If there is a critical error the red and blue indicators are on.
If the LEDs directly on the laser (see Chapter 3 - Indicator lamps) are not observable due to installation reasons a red LED has to be connected to X2: Pin3 to show laser readiness or laser activity.
X3 Connector Schematic - Product Detector

X6 Connector Schematic - Shaft Encoder

In order to use the shaft encoder as a print-go source ensure that pins 3 and 4 are connected.

In this configuration no additional product detector should be connected.
The product detect interface offers NPN or PNP standard wiring. Different types of product detect sensors (optical, magnetic, etc.) can be connected to this input. A shaft encoder may be connected here.

Connector Type:
- IEC 60130-9 Type 08 way female

Mating Cable Connector (IP67 Types):
- Lumberg: 033208-1

**Pin description**
- Pin 1 +24VF - 24V floating, max 120mA
- Pin 2 GNDF - Floating Ground
- Pin 3 PD+ - Product Detect positive input
- Pin 4 PD- - Product Detect negative input
- Pin 5 CHA+ - Encoder Channel A positive input
- Pin 6 CHA- - Encoder Channel A negative input
- Pin 7 CHB+ - Encoder Channel B positive input
- Pin 8 CHB- - Encoder Channel B negative input

All input circuits contain opto couplers.

The input range is 10-30V, (NPN, PNP, RS422 differential) at an input impedance of 2 kOhm.

The maximum pulse frequency of CHA and CHB is 120 kHz

The minimum pulse length of the PD input is 10 micro seconds.

The maximum current for X3, X6, X7 and X21 (optional user port) is 0.5A. In case of an over-current an automatic resettable fuse protects the system.

The Shaft Encoder input is directly connected in parallel with the Product Detect Interface. For this reason the electrical specification is identical as well.

For the same reason, the standard encoder cable has no “Z” connection in order not to get signal collision with the product detector. If needed e.g. in labeller applications, the isolated leads may be soldered to the scheduled pins, or a fully connected cable (Z-version) may be ordered.

Three different types of shaft encoders can be connected:
- NPN-types,
- PNP-types
- Differential types.
The machine interface delivers inputs and outputs to control the print process and provides status information. It can be used to communicate with a PLC or to harness external NPN or PNP type control elements.

Connector Type:
- IEC 60130-9 12 way male

Mating Cable Connector (IP67 Types):
- Lumberg: 032212

**Pin description**

Pin A +24VF - 24V floating
This pin offers 24V floating. The maximum current for X4 and X28 is 0.5A. In case of an over-current an automatic resettable fuse protects the system.

Pin B GNDF - Floating Ground.

Pin C INP_COM - This pin is defined as common pin for all inputs.

Pin D LASER_START - Mark enable input.
A logic high level on this pin puts the system into print mode and resets error messages. The laser is enabled.

*Note: This input internally works in parallel to the other (X29 and X59) Laser Start Inputs. Thus, applying of constant voltage at this pin will suppress edges coming from the other Laser Start Inputs.*

Pin E MARK_CTRL - Mark inhibit / release input
A logic high or low level at this input enables or disables the Print_Go signal delivered by pin F of the X4, pin 2 of X29 or pin3/4 of X3. The active level can be selected by software.

Pin F PRINT_GO - Print Start input
A rising or falling edge at this input starts the print. The active level can be selected by software.

Pin G PROG_IN - Programmable Input
This input is prepared for future use.

Pin H OUT_+COM - Positive common
This pin offers the positive supply input of all output opto couplers.
Pin J PRINTER READY - Laser Ready to Print DC output
This output opto coupler is switched on when the printer is ready to print. In multi head systems this pin shows the logical “AND” result of all Printer READY signals in the chain.

Pin K PRINTER BUSY - Print busy DC output
This output opto coupler is switched on while the print is processed. In multi head systems this pin shows the logical “OR” result of all Printer BUSY signals in the chain.

Pin L COMPIL e OK - Compile ok DC output
This output opto coupler is switched on when the compilation of the next print data is finished. In multi head systems this pin shows the logical “AND” result of all Compile OK signals in the chain.
Pin M NC - Not connected

Inputs:
10-30V, NPN, PNP
Input Impedance: 1 kOhm

Outputs
Solid State Relays
max. Voltage: 50V
max. Current X4 and X28 : 0.5A
The Compile OK Signal

The sequence of the Compile OK signal normally follows the ready signal. The Compile OK signal goes into high state together with or later than the ready signal - depending on the compile time of the current printing message.

There are only two cases where the CPI signal goes into low state and the RDY signal stay at high state.

Buffer Empty

The CPI signal goes low as the buffer runs empty. An error message will occur if a print is triggered with an empty buffer. Normal printing carries on if the buffer is filled with data before the next triggered print.

Lock DSP Data on Change

It is possible to use the CPI signal to detect when changes to the message have been processed. As reaction to these changes, Dynamark first lowers the CPI output and raises it again when the changes have been processed so that they are included in the next print. Note that Dynamark does not prevent marking, so print triggered while the CPI output is low will not raise a fault but only print the old data. These external changes are typically triggered via the Dynamark 4 Remote Interface or user ports.

Changes that can be used to lower the CPI output:

- activating a changed message from the editor
- SETTEXT via Dynamark 4 Remote Interface
- SETDATA via Dynamark 4 Remote Interface
- SETVAR via Dynamark 4 Remote Interface
- counter increment via user input
- text select via user input
Changes that will not lower the CPI output:

- BUFFERDATA via QuickStep Interface
- conditional printing via user input
- counter increment via print start
- date/time text elements

*Note:* Changes via the QuickStep Interface have in common that they trigger MSG 26 ("data change complete", see SETMSG) and that they can be used as part of a transaction in order to process multiple changes as one (see BEGINTRANS, EXECTRANS).

In order to activate this feature, it is necessary to set a flag in the configuration.

By default, this flag is not set and the CPI output remains high even while applying these changes.

The CPI signal will now be low as long as compilation on the DSP is forced by external modifications.

When using both options (Buffermode and “bLockDSPDataOnChange” Flag=1) both will influence the CPI signal.
How to set the Flag to Lock the DSP

This should only be done by service technicians or special trained users.

To set this flag:

- Login as service
- Go to Home > Settings > Advanced > Configuration Files.
- Select “Ultramark”.
- Select “Compiler” and the value “bLockDSPDataOnChange”.
- Set “bLockDSPDataOnChange” to 1.
X7 Connector Schematic - Fume Extraction

Laser - Controller | Customer

- Input Vacuum OK
- Input Filter OK
- Output Exhauster ON
- Exauster with Relay
- Exauster with Logic Input

24V (12V) Source
Floating
Input Filter OK

Sum load max 500mA together with X3 and X6

X7 female plug solder side

4 3 2 1 5

Logic Input Relay

L025317 Issue 5 July 2014
The drawing shows two different ways to connect a fume extraction system:

- with relay
- logic input.

Connector Type:
- IEC 60130-9 Type 6 way male

Mating Cable Connector (IP67 Types):
- Lumberg: 032206

**Pin description**

Pin 1 VAC_OK - Extraction system running input
A correctly running extraction system delivers a high level signal at this pin.
Input Impedance: 1kOhm, Input range 10-30V

Pin 2 GNDF - Floating Ground

Pin 3 FILTER_OK - IN Filter clean input
A clean filter delivers a high level at this pin.
Input Impedance: 1kOhm, Input range 10-30V

Pin 4 VAC_ON_+COM - Solid State Relay - Vacuum ON - Relay positive Common

Pin 5 VAC_ON_NO - Solid State Relay - Vacuum ON - DC
This output is used to switch on the Vacuum system by a solid state relay.
(max. Voltage: 50V, maximum current for X3/X6 and X7 is 0.5A. In case of an overcurrent an automatic resetable fuse protects the system).

Pin 6 +24VF- 24V floating
This pin can be used to drive the chiller control relay (pin 4) or to supply the feedback signals (maximum current for X3 and X6 and X7 and X21 (optional user port) is 0.5A. In case of an overcurrent an automatic resetable fuse protects the system).
INSTALLATION INSTRUCTIONS

X23 Connector Schematic - RS232 COM1

Max 232

Laser - Controller

Data Carrier Detect

TxD

Transmit Data

RxD

Receive Data

DSR

Data Set Ready

GND

Ground

DTR

Data Terminal Ready

CTS

Clear to Send

RTS

Request to Send

Customer

RS232 Interface 1 X23
Connector Type: 501 36.9 Type 8 way male (pin arrangement, solder contact)
Example: Lumberg 0317 68 1
Connector Type:
• IEC 60130-9 Type 8 way male

Mating Cable Connector (IP67 Types):
• Lumberg: 032208-1

Pin description
• Pin 1 DCD - Data Carrier Detect
• Pin 2 TXD - Transmit Data
• Pin 3 RXD - Receive Data
• Pin 4 DSR - Data Set Ready
• Pin 5 GND - Ground
• Pin 6 DTR - Data Terminal Ready
• Pin 7 CTS - Clear To Send
• Pin 8 RTS - Request To Send
X28 Connector Schematic - Air Chiller Control

Laser - Controller

Customer

Airkit/ Chiller
switching ON

Relay
Logic

Input Air OK

Input Chiller OK

Output Air/Chiller ON

24V (12V)
Source

to the other connectors

from load max. 500mA together with X4

Air OK respectively water level OK

Chiller OK

X28 plug solder side

1
2
4
3
5
6

Output Air/Chiller ON

24V (12V)
Source

Floating

2
2
Connector Type:
- IEC 60130-9 Type 6 way female

Mating Cable Connector (IP67 Types):
- Lumberg: 033206

**Pin description**

Pin 1 AIR_OK - Air_OK or Water_Level_OK input
A correctly running air system delivers a high level signal at this pin.
Input Impedance: 1kOhm; Input range 10-30V

Pin 2 GNDF - Floating Ground

Pin 3 CHILLER_OK - Chiller OK input
A correctly running chiller delivers a high level signal at this pin.
Input Impedance: 1kOhm; Input range 10-30V

Pin 4 CHILLER_AIR_ON _+COM)
Chiller/Air control relay positive common pin

Pin 5 CHILLER_AIR_ON_NO
Chiller/Air control relay normally open pin
This output is used to switch on the Chiller/Air by a solid state relay.
(Maximum Voltage: 50V, maximum current for X4 and X28 is 0.5A. In case of overcurrent an automatic resetable fuse protects the system).

Pin 6 +24V Floating
This pin can be used to drive the chiller control relay (pin 4) or to supply the feedback signals (maximum current for X4 and X28 is 0.5A). In case of overcurrent an automatic resetable fuse protects the system.
X58 Connector Schematic - Power Extension

Only needed to connect the power extension box for 60 Watt systems.
Do not connect anything else to this connector.
X59 Connector Schematic - Ethernet 2 - Remote Panel Interface

**Laser - Controller**

**Customer**

**Remote Panel Power Input**

- **TX+**
- ** TX-**
- **RX+**
- **RX-**
- **Laser Start Input**
- **Laser Start Input**
- **24V floating output**
- **Ground floating**

**Ethernet 2 (Remote Panel Interface) X59**

The second Ethernet interface will be used for a remote panel. A Laser Start Input can be used for enabling the printer.

**Connector Type:** IEC 61300-9 Type 7 way female (solder contact)

**Example:** Lumberg 1019 07

- Power on output Pin 1: 24V at 1.5A
- Pin 7: input of 10-30V against floating GND. Impedance 2kOhm
- Pin 3-6: according to IEEE standard 802.3

**X59 plug solder side**

4 3
5 7 2
6 1

---

L025317 Issue 5 July 2014 2-33
The second Ethernet interface is used for a remote panel pre-configured to the IP address 192.168.57.2 / subnet mask 255.255.255.0.

A Laser Start Input can be connected for laser start by means of a mechanical switch against floating GND (between pin 7 and pin 2).

Connector Type:
- IEC 60130-9 Type 7 way female

Mating Cable Connector (IP67 Types):
- Lumberg: 033207

**Pin description**
- Pin 1 +24VF - 24V floating. This pin can be used to drive a remote panel with 24V at 1.5A
- Pin 2 GNDF - Floating Ground
- Pin 3 TX+ - Transmit +
- Pin 4 TX- - Transmit -
- Pin 5 RX+ - Receive +
- Pin 6 RX- - Receive -
- Pin 7 LSTART_INP - static Laser Start Input. By applying voltage to this input the laser may be started; including enabling of the printer. Input level 10-30V; input impedance: 2 kOhm, referenced to Pin 2 GNDF Floating Ground. The voltage available at pin 1 may be used.

*Note: This input internally works in parallel to the other (X4 and X29) Laser Start Inputs. Thus, applying of constant voltage at this pin will suppress edges coming from the other Laser Start Inputs.*

If in a multiple head system the install option “Laser On level sensitive” is activated, this input can only be used for the first controller next to the machine (“primary”) as Laser Start Input.

Applying of constant voltage at this pin of a “secondary” controller of a multiple head system would disturb the internal communication between the controllers and would lead to malfunction.

**WARNING:** Attention: this connector does not offer a “laser switch off” input.
SAFETY OF THE LASER SYSTEM

The safety of a laser guarding is ensured by interlock doors which must be equipped with interlock switches which are observed by a certified safety relay.

The former standard EN 954 Part 1 classified the safety of machines into five categories: B, 1, 2, 3, and 4.
According to the risk analysis of Domino Laser GmbH for laser coding systems safety category 2 had to be reached. An electrically single circuit connection was sufficient for the safety doors when using the safety relay “PNOZ-S4”.

EN 954 has been replaced by EN 13849.

Since the beginning of 2012 the risk analysis has to be done according to the standard EN 13849. This standard distinguishes between different performance levels: a, b, c, d, and e. A risk analysis according to this standard leads to the result that performance level d has to be reached. Therefore a two circuit connection is needed to the safety relay as it has been needed for category 3.
This means that the laser system has to be connected by a double circuit connection to double switches of the safety door. This double switch needs to have forcibly guided contacts of the type “normally closed”.

When using this double circuit connection operation with or without cross-wire short detection is possible.
Cross-wire short detection means that the safety relay detects a short between the two circuits. A short may be produced by damaging an interlock cable, e.g. by a vehicle in a factory hall.

Without cross-wire short detection performance level d is reached.
With cross-wire short detection performance level e is reached.

The functionality cross-wire short detection is activated on the Pilz safety relay. Cross-wire short detection is switched off when using the setting “Cat 2/3”. It is active when using the setting “Cat 4”.
The setting of the category has to match the wiring at the safety relay.
X29 Connector

The installation of Performance Level \_c is no more permitted since the new safety rules of 2012.
PCB Connector Type:
- IEC 60130-9 Type 7 way male

Mating Cable Connector (IP67 Types):
- Lumberg : 0322 07

Pin description
- Pin 1: L1_SOURCE - Positive Interlock Source / +24V floating. This pin delivers a current limited 24V source and can only be used to drive Pin 2, Pin 3 and Pin 7 of this connector.
- Pin 2: PRINT_GO - Print Start Input. For external “print go” this pin can be driven with 24V delivered by pin 1.
- Pin 3: IL1_INP - positive Interlock1 Input. This pin is used as input for the first interlock loop in the CAT2-4 modes.
- Pin 4: L2_GND - GND pin interlock loop 2
- Pin 5: IL2_INP - Negative Interlock2 Input. This pin is used as input for the second interlock loop.
- Pin 6: Printer Ready Output. This output opto driver is switched on when the printer is ready to print. In multi head systems this pin (at the “primary” controller only available) shows the logical “AND” results of all “Printer Ready” signals in the chain. This output opto driver is protected with an auto-resetting fuse with a current limit of 100 mA. The output voltage is +24V floating. The appropriate GND is delivered on pin 4. In multi head systems this pin (at the “secondary” controllers) are automatically switched to a serial mode to handle the internal communication between the controllers.
- Pin 7: EXT_LSTART_IN - External Laser Start Input. The laser can be switched on by placing a pushbutton or a switch between pin1 (current limited 24V) and pin 7 (External Laser Start In). This input is internally working in parallel to the other (X4 and X59) Laser Start Inputs. Thus, applying of constant voltage at this pin will suppress edges coming from the other Laser Start Inputs.

The PILZ safety relay has a small selection wheel on the enclosure to select CAT2/3 or CAT4.
Timing

The next picture shows the general E-Stop Relay timing:
Typical installation faults

The interlock door has to be equipped with double switches to reach the requested safety level.

If one switch fails the other switch will ensure safety level.

Both interlock circuits have to be connected to the same safety door.

A typical installation fault when interlock circuit 1 is only connected to safety door 1 and interlock circuit is only connected to safety door 2.
COMPRESSED AIR CONNECTION, LENS

The scanner head can be equipped with a connection for compressed air. Compressed air keeps the objective lens of the D120i, D320i and D620i free from dust. It requires a 6mm diameter hose.

To fit the compressed air hose:

- Push the sleeve nut over the hose
- Push the hose onto the air connector and tighten the sleeve nut.

Only clean and dry compressed air, free of oil, should be used, to avoid damage to the lens.
COMPRESSED AIR CONNECTION

COOLING D120i IP D320i IP

The laser head is equipped with a connection for compressed air to cool the laser.

An optional air installation kit, for treating factory air that is to be supplied to the laser head, is available. The air kit includes an air filter, regulator, coalescing filter, a control solenoid and cable, fittings, and 12 meters of 12mm tubing.

CAUTION: Only clean compressed air, free of oil, to Class 1.7.2 of ISO8573 should be used to avoid damage to the lens and laser tube.

Notes: (1) Check that thread tape is applied prior to assembly.
(2) Minimum 58 psi/4 bar factory air supply needed to operate the kit
(3) Maximum pressure is 10 bar.

D-Series Air Filtration Kit, Part Number EPP002300

! CAUTION: Only clean compressed air, free of oil, to Class 1.7.2 of ISO8573 should be used to avoid damage to the lens and laser tube.
Connection of Compressed Air to the Laser

**WARNING:** Operating air pressure is 4 bar!

Connect the hose from the air installation kit to the laser compressed air inlet.

A safety valve is at the air inlet. It opens if the air flow at the inlet exceeds 450 lpm.

For safety reasons there are two separate outlets for compressed air. To one of them a silencer is connected (Air Outlet 2). A hose is connected to the other one (Air Outlet 1). The end of this hose has to be installed in a way that it does not get blocked at any time or that water may infiltrate into the hose. Please check the outlets for blocking and dirt on a regular monthly basis. Blocked outlets may damage the laser!

One may check the function of the safety valve upon installation. Turn the line pressure up to 3,5 bar to 4,5 bar until the safety valve opens. Reduce the pressure by 0,1 bar to ensure the correct air flow. Please note that air pressure is only applied to the safety valve if the switch valve inside the laser head is open. If it is closed there is no air flow through the laser head.

Both air outlets must be kept clear. Only one silencer has to be installed to the air outlets. Do not use silencers on both air outlets. Do not swap inlets and outlets for compressed air.

Check the silencer for dirt once a year. Remove the stainless steel housing to check the silencer.

Minimum inner diameter of the outlet hose must be 12 mm. The length of the outlet hose must not exceed 4 metres.
AIR FLOW SETTINGS

The air flow through the laser head and thereby the consumption of compressed air is controlled by an internal switch valve.

In order to reach the specified cooling capacity the line pressure before the laser head must be set to approximately 3.5 bar. This results in an air flow of 400 litres per minute if the switch valve is open.

In order to prevent the laser from damage the switch valve opens for 60 seconds each time the marking system is set to its “Ready” state. After this sequence the switch valve opens every 10 seconds. Check and re-adjust the line pressure during the first off cycles after the initial 60 seconds cooling period. The flow control mechanism monitors the temperature of the laser source and adjusts the length of the periods where the switch valve is open. If the laser is running cold, the air flow is engaged for 1 second. Once the laser heats up this period gets longer until the open state would last for more than 9 seconds. At this point the valve will stop switching and remains open.

Air Flow without Air Chiller

D120i

These are examples of typical air flows for the D120i.

D120i Ambient temperature (in °C) vs. maximum mark duty cycle (in %) depending on airflow (in LPM)
Without air chiller
D320i

These are examples of typical air flows for the D320i.

D320i Ambient temperature (in °C) vs. maximum mark duty cycle (in %) depending on airflow (in LPM) Without air chiller
Air Flow without Air Chiller

If the ambient air temperature exceed 30°C and the duty cycle is higher than 50% an air chiller should be used.

**D120i**

All curves are recorded with the original D-Series air kit. The maximum hose length when an air chiller is used is 4 meters from the chiller to the laser head. In this case the air kit is installed between air chiller and laser head. An air chiller type SMC (Model: IDFA8E) has been used as reference. The actual pressure depends on the installed length of the hose.

![Diagram: D120i Ambient temperature(in°C) vs. maximum mark duty cycle (in %) depending on airflow (in LPM) With air chiller](image-url)
D320i

All curves are recorded with the original D-Series air kit. The maximum hose length when an air chiller is used is 4 meters from the chiller to the laser head. In this case the air kit is installed between air chiller and laser head. An air chiller type SMC (Model: IDFA8E) has been used as reference. The actual pressure depends on the installed length of the hose.

*D320i Ambient temperature (in °C) vs. maximum mark duty cycle (in %) depending on airflow (in LPM) With air chiller*
COOLING THE i-TECH 15 SCAN HEAD

The i-Tech 15 is an extremely fast scan head with relatively large and fast mirrors. This allows for superior performance in applications where a large marking field is required.

In order to ensure reliable operation of the scan head at high temperatures and/or high duty cycles the scan head may need additional cooling. To avoid interruptions in the manufacturing processes we strongly recommend a careful evaluation of the given conditions. The table on the next page provides information about when to use additional compressed air cooling in typical marking applications.

The Mark Duty Cycle (MDC) may be calculated using this formula:

- Duty Cycle (%) = (mark time (ms) x product rate (products/s)) / 10
- Example e.g. for a message of 50ms mark time printing 4 prints per second. The duty cycle is 50 x 4 / 10 = 20% in this example.

Operating pressure is 4 bar.

To cool the scan head, connect the compressed air to the inlet and the silencers to the air outlets.
Air Flow Settings for the i-Tech 15 Scan Head

The components from air kit L015288 are used to connect the compressed air cooling and to install the silencers.

We recommend using the Domino standard air kit EPP002300, especially if you are not sure about the available air quality or line pressure.

The settings for the throttle valve are given for a line pressure of 4 bar using the Domino air kit. In the first step the throttle valve is completely closed - no air flow through the scan head. In order to set the correct air flow open the valve by turning the knob. The number of turns needed is given in the table below.

<table>
<thead>
<tr>
<th>Turns</th>
<th>Airflow</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>l/min</td>
</tr>
<tr>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>8</td>
<td>50</td>
</tr>
<tr>
<td>9.5</td>
<td>75</td>
</tr>
</tbody>
</table>

The following table shows the air flow to adjust depending on the ambient temperature and the mark duty cycle (MDC).

<table>
<thead>
<tr>
<th>Ambient temperature</th>
<th>Without cooling</th>
<th>With cooling</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MDC</td>
<td>MDC</td>
</tr>
<tr>
<td>25°C</td>
<td>100%</td>
<td>100%</td>
</tr>
<tr>
<td>30°C</td>
<td>90%</td>
<td>100%</td>
</tr>
<tr>
<td>35°C</td>
<td>75%</td>
<td>100%</td>
</tr>
<tr>
<td>40°C</td>
<td>60%</td>
<td>100%</td>
</tr>
</tbody>
</table>
WATER COOLING D620i

The water chiller and compressed air must be connected to the laser. To avoid damage to the laser tube, only clean compressed air free of oil, to Class 1.7.2 of ISO8573 should be used. The compressed air is used to prevent too high humidity values inside the laser module. Therefore to prevent water condensation inside the laser module.

Adjust the pressure of the compressed air between 2.5 and 3 bar. This equals an air flow rate of 20 litres per minute. The water chiller is operated by the controller via the X28 connector. Also switching on and off is done via this connection.

See the water chiller manual for more details. Coolant may be ordered from Domino. The coolant has to be exchanged at least every two years.

Note: Contact Domino before disconnecting the silencer or connecting a hose to the air outlet 2 at the laser. If two hoses are used for the compressed air outlet these have to be placed in different positions for safety reasons.
Both air outlets must be kept clear. Only one silencer has to be installed to the air outlets. Do not use silencers on both air outlets. Do not swap inlets and outlets for compressed air.

The outer diameter of the outlet hose must be 12 mm. The length of the outlet hose must not exceed 10 metres.

**CAUTION:** Follow the safety guideline of chapter 1 regarding water cooling.

**Note:** It is possible to operate an air kit and a water chiller in parallel. Both are activated via X28. For details see the water chiller manual.

### FUME EXTRACTION SYSTEM

Domino recommend installing the DPX500, DPX1000, DPX1500 or the DPX2000 fume extraction and purifier system. These are designed to protect personnel from hazardous dust and fumes that may be produced by the laser marking process.

The DPX1000 is a general purpose fume extraction system that removes particulates. The DPX2000 fume extraction system has an additional filter and a chemical pad to remove odours and toxic gases. The DPX500, DPX1000, DPX1500 and DPX2000 will be equipped with a connector for the Domino D-Series Laser System.

**WARNING:** When printing onto PVC material, the DPX2000 Extractor should be used due to the toxic and corrosive gases expelled during the process.

For details, see the manual included with the Fume Extraction system.
GUARDING

Guarding must be installed surrounding the laser head marking area in order to achieve a Class 1 installation of this Class 4 laser system (See “Access Guards”).

INITIAL OPERATION

WARNINGS:  
(1) Initial Operation of the laser marking system must only be performed by qualified personnel and in accordance with all valid regulations and safety instructions.

(2) Refer also to PART 1: “HEALTH & SAFETY”.

CAUTION: When the controller unit has been switched on, electrical connections must not be connected or disconnected.

(1) At the control panel, release the On/Off button by turning it clockwise. Wait until the BOOT READY indicator has illuminated. (refer also to “QUICKSTEP INTERFACE” on page 3-15).

(2) The QuickStep software will start automatically. After approximately 20 to 40 seconds the QuickStep user interface will be displayed on the touch panel (refer also to “QUICKSTEP INTERFACE” on page 3-15).

(3) Check the following:
   (i) Ventilation fans on the sides of the controller unit are running.
   (ii) The PRINTER READY indicator on the controller unit is illuminated.
   (iii) The fume extraction system has started, and no faults are displayed.

If the laser marking unit is equipped with a compressed air connection, the compressed air system should be turned on.
INITIAL SETUP WIZARD

This procedure is for trained personnel only. When logged in with a password for the supervisor user level, this initial setup wizard will not be available to the operator.

The initial setup Wizard is the simple way to configure the printer.

Note: System settings can only be changed after entering the administrator password, which is only known by employees authorised to carry out this level of change. This manual is intended for supervisor level and does not cover installation.

(1) Home screen to login.

(2) Select Home > Settings > Initial Setup Wizard

Note: Setup procedure should be completed by a trained service technician.
POSITIONING CODE ON THE PRODUCT

The position of the code on the product depends on two factors:

1. The location of the product detector (print-go), relative to the mark window on the product; and
2. The ‘Encoder Delay’ setting in the software.

The D-Series laser can start marking as soon as the print-go signal is received. In most situations, the mark can be moved on the product by moving the product detector upstream or downstream (i.e. triggering the marking process to start earlier or later).

By moving the product detector in the opposite direction to the direction of travel, the print is triggered earlier, and the mark moves further to the left within the Mark Window. By moving the product detector with the direction of travel, the print is triggered later and so the mark moves to the right of the Mark Window.

In some instances, it is not possible to relocate the product detector. The D-Series includes a feature called ‘Encoder Delay’, that allows the coder to wait a defined number of encoder pulses before starting the marking process. Since the encoder is measuring the distance that the product has travelled, this allows the print-go signal to be delayed by a known and user-defined distance of product travel.

Note that the encoder delay can only be used to make the marking start later. In the example above, this would move the mark to the right within the mark window.

In the example above, if the detector is upstream (before) the laser head, the print would be triggered too early to print in the mark window, so the encoder delay would be used to locate the print in the correct position.
The encoder delay can be set on a message-by-message basis, which allows a single product detector location to be used for multiple sizes of product or to allow different code locations on products of the same size.

To set the encoder delay login as administrator and navigate to:

Home > Settings > Production Line Setup > Line Movement > Encoder Setup

Encoder Delay = 0, unused

Encoder Delay in use, delaying the marking process and moving the code, without changing the location of the sensor or print head.
Achieving Maximum Line Speed

The D-Series includes a feature to extend the marking field when a moving product is marked as it moves past the print head. This feature is used to achieve maximum line speed.

Marking mode has to be configured for “Mark on the Fly”.

Adjust the marking mode via: Home > Settings > Production Line Setup > Line Movement > Setup Line Movement

Normally the first object in the direction of movement of a message is marked when it has entered the marking area below the laser lens.
Example of a setup message to be marked.

Marking starts when the marking field of the product is moved into the marking area of the laser.

To achieve maximum line speed, the field can be extended behind the marking direction. The marking starts when the object enters the marking area.
To extend the marking field move the object in the opposite direction to the movement outside the marking field (see dotted line of the field borders).

Marking starts as the product marking field enters the marking area.

Note: Moving the mark on the screen, whether in the real or extended fields, can move the mark on the product. First set the ideal position of the mark on the screen, then adjust the product detector (print go) or change the encoder delay to set the actual mark position onto the product.
Making marks longer than one field size

By using extended fields it is possible to mark an object that exceeds one field size.

The procedure is the same as described previously on extending the marking field. Move the marking object out of the real field against the product movement direction and into an extended field.

RapidScan Technology

To achieve higher marking speeds it is possible to rotate the marking field in 45° angle steps against the product movement direction. This has to be set up in the initial setup wizard by an administrator or by a service technician. The scanner is installed in a 45° angle in relation to the product movement direction.

When the RapidScan option is not used the scanner and marking field have 90° angle steps to the product movement direction.
With active RapidScan the angle between marking field (red) and product movement direction is at 45° and consequently the length of the marking field in the product movement direction is increased.

Scanner at 90° angle to the product

Scanner at 45° angle to the product
Product Distance and Print Start - Ignore Distance

With this feature it is possible to set a minimum and maximum distance between two products to mark.

Login as administrator and navigate to:

Home > Settings > Production Line Setup > Line Movement > Product Distance

Setup the “Maximum Distance” and / or the “Print Start Ignore Distance” in millimetres.

Both options are deactivated by setting the distance to 0.00 mm.

To activate one or both options enter a distance.

If “Maximum Distance” is exceeded by passing products between two print start signals an error message is displayed: “Maximum print to print distance exceed”. The error ID is 14. The system is not any longer ready for printing.

If “Print Start Ignore Distance” is under-run by passing products between two print start signals a warning message is displayed: “Print start signal ignored”. The error ID is 15. The second print start signal is ignored and does not lead to a print on the product. A possible “Print Start while Printing” error is suppressed.
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>D-SERIES LASER MARKING SYSTEM</strong></td>
<td>3-5</td>
</tr>
<tr>
<td>D120i and D320i</td>
<td>3-5</td>
</tr>
<tr>
<td>D520i IP and D620i IP</td>
<td>3-6</td>
</tr>
<tr>
<td><strong>CONTROLS AND INDICATORS</strong></td>
<td>3-7</td>
</tr>
<tr>
<td>Touchpanel and Interface</td>
<td>3-7</td>
</tr>
<tr>
<td>Controls</td>
<td>3-7</td>
</tr>
<tr>
<td>Indicator Lamps</td>
<td>3-8</td>
</tr>
<tr>
<td>Additional Indicator Lamps D620i</td>
<td>3-9</td>
</tr>
<tr>
<td><strong>SWITCHING ON AND OFF</strong></td>
<td>3-10</td>
</tr>
<tr>
<td>Switching On the Control Unit</td>
<td>3-10</td>
</tr>
<tr>
<td>Switching On the Laser Head</td>
<td>3-10</td>
</tr>
<tr>
<td>Switching Off the Laser Head</td>
<td>3-10</td>
</tr>
<tr>
<td>Switching Off the Control Unit</td>
<td>3-10</td>
</tr>
<tr>
<td><strong>D-SERIES CONNECTIVITY</strong></td>
<td>3-11</td>
</tr>
<tr>
<td>Webserver</td>
<td>3-12</td>
</tr>
<tr>
<td><strong>QUICKSTEP INTERFACE</strong></td>
<td>3-13</td>
</tr>
<tr>
<td>Home Screen</td>
<td>3-13</td>
</tr>
<tr>
<td>Status Bar</td>
<td>3-14</td>
</tr>
<tr>
<td>General Functions</td>
<td>3-15</td>
</tr>
<tr>
<td><strong>INITIAL SETUP</strong></td>
<td>3-16</td>
</tr>
<tr>
<td>Display Settings</td>
<td>3-16</td>
</tr>
<tr>
<td>Setting the Master Clock</td>
<td>3-16</td>
</tr>
<tr>
<td><strong>Production Line Setup</strong></td>
<td>3-17</td>
</tr>
<tr>
<td><strong>Security Management</strong></td>
<td>3-18</td>
</tr>
<tr>
<td>Security Mode</td>
<td>3-18</td>
</tr>
<tr>
<td>Add/Change User</td>
<td>3-19</td>
</tr>
<tr>
<td>Delete a User/Change Password</td>
<td>3-19</td>
</tr>
<tr>
<td>Groups</td>
<td>3-19</td>
</tr>
<tr>
<td>Specify Password Policy</td>
<td>3-19</td>
</tr>
<tr>
<td>Electronic Signature</td>
<td>3-19</td>
</tr>
<tr>
<td><strong>Global Print Settings</strong></td>
<td>3-20</td>
</tr>
<tr>
<td>Print Field Offset</td>
<td>3-20</td>
</tr>
<tr>
<td>Message Options</td>
<td>3-20</td>
</tr>
<tr>
<td>Marking Engine</td>
<td>3-20</td>
</tr>
<tr>
<td>Setup Aiming</td>
<td>3-21</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Content/Shift Codes</td>
<td>3-21</td>
</tr>
<tr>
<td>Clocks/Dates</td>
<td>3-22</td>
</tr>
<tr>
<td>CREATING AND EDITING A MESSAGE</td>
<td>3-23</td>
</tr>
<tr>
<td>Add Text</td>
<td>3-23</td>
</tr>
<tr>
<td>Unicode</td>
<td>3-24</td>
</tr>
<tr>
<td>Common Unicode Characters</td>
<td>3-24</td>
</tr>
<tr>
<td>Input Method Editor (IME)</td>
<td>3-24</td>
</tr>
<tr>
<td>General Property Values</td>
<td>3-25</td>
</tr>
<tr>
<td>Conditional Printing</td>
<td>3-26</td>
</tr>
<tr>
<td>Text object properties</td>
<td>3-27</td>
</tr>
<tr>
<td>Add a New Barcode</td>
<td>3-28</td>
</tr>
<tr>
<td>Barcode Object Properties</td>
<td>3-28</td>
</tr>
<tr>
<td>Add an Image</td>
<td>3-29</td>
</tr>
<tr>
<td>Image Object Properties</td>
<td>3-29</td>
</tr>
<tr>
<td>DXF Import</td>
<td>3-30</td>
</tr>
<tr>
<td>Add a Shape: Arc/Rectangle</td>
<td>3-31</td>
</tr>
<tr>
<td>Arc Object Properties</td>
<td>3-31</td>
</tr>
<tr>
<td>Rectangle Object Properties</td>
<td>3-31</td>
</tr>
<tr>
<td>Add a New Variable</td>
<td>3-32</td>
</tr>
<tr>
<td>Add a New Clock</td>
<td>3-33</td>
</tr>
<tr>
<td>Add a New Counter</td>
<td>3-33</td>
</tr>
<tr>
<td>Add a New Prompted Field</td>
<td>3-35</td>
</tr>
<tr>
<td>Add a New Link</td>
<td>3-36</td>
</tr>
<tr>
<td>Add a New Script</td>
<td>3-36</td>
</tr>
<tr>
<td>Add a New Coding</td>
<td>3-37</td>
</tr>
<tr>
<td>Add a New Shift Code</td>
<td>3-37</td>
</tr>
<tr>
<td>Add a New Text Insert</td>
<td>3-38</td>
</tr>
<tr>
<td>Add a New Text Variable</td>
<td>3-39</td>
</tr>
<tr>
<td>Add a New Text Link</td>
<td>3-39</td>
</tr>
<tr>
<td>Undo / Redo</td>
<td>3-40</td>
</tr>
<tr>
<td>File</td>
<td>3-40</td>
</tr>
<tr>
<td>Parameter Set</td>
<td>3-41</td>
</tr>
<tr>
<td>Standard Parameters</td>
<td>3-43</td>
</tr>
<tr>
<td>D120i</td>
<td>3-43</td>
</tr>
<tr>
<td>D320i</td>
<td>3-44</td>
</tr>
<tr>
<td>D620i</td>
<td>3-45</td>
</tr>
<tr>
<td>Edit</td>
<td>3-46</td>
</tr>
</tbody>
</table>
OPERATION

Add ........................................................................................................... 3-46
Move .......................................................................................................... 3-46
Zoom ......................................................................................................... 3-47
Re-order Visual Items ............................................................................... 3-47
Item Selection List ................................................................................ 3-47
Resize ........................................................................................................ 3-47
MESSAGE STORE AND FILE MANAGEMENT ........................................ 3-48
Selecting an Existing Message ................................................................. 3-48
File Manager .......................................................................................... 3-48
BACKUP AND RESTORE ........................................................................... 3-49
Backup ..................................................................................................... 3-49
Restore .................................................................................................... 3-49
Update ..................................................................................................... 3-49
Defaults ................................................................................................... 3-50
PRINTER STATUS ...................................................................................... 3-50
ADVANCED SETTINGS ................................................................................ 3-50
Laser Parameters .................................................................................... 3-50
Configuration Files .................................................................................. 3-51
Install Options ........................................................................................ 3-51
DIAGNOSTICS .......................................................................................... 3-51
Status ....................................................................................................... 3-51
Logs .......................................................................................................... 3-51
Audit Trail Log ........................................................................................ 3-52
Status Log ................................................................................................ 3-52
ALERT CONFIGURATION ........................................................................... 3-52
Configure Alerts ...................................................................................... 3-52
Ranged Alerts ......................................................................................... 3-52
IO PORT ..................................................................................................... 3-52
Assignment .............................................................................................. 3-52
Test ........................................................................................................... 3-53
Message Select ....................................................................................... 3-53
PRINTER NETWORK .................................................................................... 3-54
Ethernet ...................................................................................................... 3-54
Multi-Head .............................................................................................. 3-54
Serial ........................................................................................................ 3-54
Advanced ............................................................................................... 3-54
SYSTEM INFORMATION ............................................................ 3-55
  Overview ................................................................................. 3-55
  Software Versions ................................................................. 3-55
  Hardware Versions ................................................................. 3-55
USER INTERFACE ...................................................................... 3-56
  Printer Connection ............................................................... 3-56
  Language & Keyboard ............................................................ 3-56
  Network .................................................................................. 3-56
  Versions Information ............................................................... 3-56
INITIAL SETUP WIZARD ............................................................. 3-57
D-SERIES LASER MARKING SYSTEM
D120i and D320i

Optional User Interface, Control Unit and Laser Unit with Scanner
D520i IP and D620i IP

- Laser key switch
- Optional Touchpanel
- D-Series IP55 Control unit (60W)
- On/Off Switch
- Mains connector
- Laser Lens
- Scanner Head
- Laser Unit (IP65 water cooled)
CONTROLS AND INDICATORS

The User Interface, Indicator Lamps and Software icon functions are described in the following paragraphs:

**Touchpanel and Interface**

The software is operated via a PC keyboard, Touchpanel or Web Browser. An entry is confirmed with the left mouse button if PC or Web browser are used. The optional Touchpanel if connected, allows entry by touching the tabs and function keys on the screen. An onboard keyboard is included in the software.

*Note:* *The Web Browser does not support the message editor.*

**Controls**

ON / OFF BUTTON - Starts and stops the controller and PC unit

KEY SWITCH - Starts and stops the Laser Unit (fans and laser tube start).

The key switch has three positions

- "0" Laser off
- "1" Laser ready
- "***" Laser start.
Indicator Lamps

- Interlock 1 - Illuminates when the interlock 1 is closed.
- Interlock 2 - Illuminates when all the interlocks are closed.
- PC Ready - Illuminates when the internal PC is ready.
- Printer Ready - Illuminates when the Laser is powered up and marking system is ready to print.
- Printer Busy - Illuminates when the Laser is marking.

Laser emission is also indicated by a red ready LED on the front and rear of the laser unit. The ready LED is powered by the laser voltage.
The status LED is a multi-colour LED which indicates:

**Green**
System ready, no errors, no laser operation.

**Red**
Laser operation, to show short laser operation periods, the LED remains illuminated for a longer period than the actual laser operation.

**Yellow**
Error or warning, additional information may be shown by a flashing yellow LED for service technicians.

A second ready LED is located on the back of the laser unit.

**Additional Indicator Lamps D620i**

- 5V - green: 5 V for digital logic available
- 24V - green: 24 V for control voltage power contact
- OK - green: No internal error status
- Warning - yellow: Emergency operation
- Over temperature - yellow: Cabinet temperature is too high
SWITCHING ON AND OFF

WARNINGS:
1. The laser marking system must only be used for its intended purpose.
2. The laser marking system may only be operated by trained personnel.
3. Operation is only allowed with all required cables connected and all parts mounted. Do not disconnect any cables during operation.
4. Refer also to PART 1: “HEALTH & SAFETY”.

CAUTION: The lens cap, used to prevent damage or external soiling that will cause a reduction in laser performance, must be removed before operation.

Switching On the Control Unit
At the control panel, release the On/Off button by turning it clockwise. Wait until the SERVER RUNNING indicator has illuminated.

Switching On the Laser Head
Turn the key switch from position "0" to position "1". To start the laser turn the key clockwise to the laser symbol and hold it for at least 1 second. The key automatically turns back to position "1".

- For 30 Watt systems, the laser needs a warm-up phase.
- For 60 Watt systems, the laser needs a warm-up phase and tests whether the laser is ready by printing a test print; so there is a very fast test print before a print signal.
- Please follow laser safety precautions before and after switching on the laser.

The PRINTER BUSY indicator will illuminate when the laser hardware is switched on.

The PRINTER READY indicator illuminates. After initialising the Dynamark 4 software and starting the lasers, the marking system is ready. Laser emission is also displayed by a red LED on the rear of the laser unit.

Switching Off the Laser Head
(1) Turn the key switch from position "1" to position "0". The laser hardware is switched off.

Switching Off the Control Unit
(1) Press the On/Off button. The computer will immediately switch off.
D-SERIES CONNECTIVITY

The D-Series is operated either via a remote TouchPanel or via a PC running on Microsoft Windows 7® or Windows 8® with installed Quickstep software.

To connect to one D-Series, the TouchPanel is connected to the X59 TouchPanel connector of the controller.

The TouchPanel then displays the UI relating to that printer.

One TouchPanel can control multiple D-Series in the same network if required.

Details about the printer being controlled are displayed in the Home screen, which lists: the logged in user, the printer name and model. To connect to another printer in the network, follow the steps below:

- Disconnect from the current printer by pressing the Lock button and selecting Disconnect From Printer to display the printers' list screen.
- Press the Lock button and select Unlock UI Settings, enter the password (QS).
- Press Settings, select Broadcast (default) as the connection method.
- Go back to the printers' list screen and press Refresh to view a list of all printers in the network.
- Select the required printer.
A list of favourite remote printers can be created, as follows:

- From the printer’s list screen, press the Lock button and select Unlock UI Settings, enter the password (Domino1).
- Press Settings and select Favourite as the connection method.
- Press Add Favourite and fill in the required fields manually or get a favourite printer from broadcast.
- Select a printer from the broadcast list.
- Press Add to Favourites.

**Webserver**

One may also connect to the printer’s UI via standard web browser. The following web browsers are supported:

- Microsoft Internet Explorer from version 9.0 on
- Mozilla Firefox from version 22 on
- Google Chrome from version 27 on
- Apple Safari from version 6 on

Not all functionality of the UI is available when connecting via a web browser.

**Not** available is:

- the message Editor which is accessed via *Home Screen > Settings > Message Editor* or via *Home Screen > Messages > New Message / Edit Printing Message*

To connect, enter “http://[IP address of the controller]” in the address field of the web browser.
QUICKSTEP INTERFACE

Home Screen

When starting the printer, the following Home screen is displayed.

Status Icons: Displays current status of printer, e.g:
- Laser active: (Laser is busy - laser emission!)
- USB device connected: (USB device connected to controller or TouchPanel)
- Dongle connected: (Pharma or Service dongle connected)

Status Bar: Displays printer and alert status. If more than one alert is present, the highest priority alert is displayed.

Start/Stop Button: Enables marking: If the laser unit is switched off, it must be switched on before marking can take place.
- Stops marking
- Triggers a print
- Restarts the Printer
Zoom Toolbar: Zoons in and out and to marking field
Live Message Preview: Main working area. Used for settings and message creation.
Main Menu Selection Buttons: Navigate to the four main QuickStep areas where all functions of the operational software can be accessed.
Lock Button: • Locks the screen to prevent accidental changes
                         • Login and logout
                         • Disconnects from printer
Printer Name: Shows the printer currently being controlled

**Status Bar**
The status bar displays informal, warning and error messages in different colours:

- **Green** - the condition is normal, no action is required.
- **Blue** - the condition requires attention but does not prevent marking except when the system is in standby mode.
- **Yellow** - the condition prevents marking, however if marking was enabled and the reason for this fault has become obsolete it automatically re-enables marking.
- **Red** - the condition prevents marking and requires immediate correction.

*Note: Click on the status bar to acknowledge errors.*
**General Functions**

The following illustration shows the Global Print Settings screen and the various screen areas.

Click long on a button to get a description. Click long on a button of the Settings area to move this button to the Home screen.

*Note: The breadcrumb navigation shows the current location inside the menu structure. Switch the user interface level by clicking on the icons; it is also a quick way to return to the home screen from any page.*
INITIAL SETUP

The initial setup configures the overall look of the interface and also configures basic settings and presets for printer operations.

Display Settings

Home > Settings > Regional > Language and Keyboard

Set:
- Language.
- Keyboard layout.
- IME Scheme.
- Primary currency.

Setting the Master Clock

Home > Settings > Regional > Date and Time

Set:
- System date.
- System time (24 hour clock).
- Time zone.
- Automatic Daylight Saving Time.
- Setup the Network Time Protocol.
Production Line Setup

Home > Settings > Production Line Setup

Set:

- **Printer Orientation**: Rotates the print head and/or product to set the correct orientation. One may mirror the print. Set the vector sorting direction in such a way that marking is processed in the opposite direction to the direction in which the product is moving. If “none” is selected, the vectors will be processed in the normal marking order of the objects.

- **Print Field**: Sets the usable dimension and scanner dimension of the print field width, height and centre point. Set restriction for the print field. Trigger a test print to measure the field to setup the field size.

- **Optics**: Select the correction matrix for the used scanner and lens configuration and make a test print of it. Select the tube distortion axis to mark round objects.

- **Line Movement**: Product Line Movement: Static or mark on the fly. Encoder Setup: Source, scale delay and field usage PN Transformation. Product Distance: Maximum distance and print start ignore distance see “Product Distance and Print Start - Ignore Distance” on page 2-61.

- **Print Trigger**: Product Detect. Continuous Printing: Trigger a print by given time interval. Debounce Settings: Set the ramp times.

- **Shift Register**: Enable the shift register between trigger signal and print on the product and set the depth.
Security Management

Password protection prevents unauthorised changes to the software, and unauthorised operation of the laser marking system.

Some functions can only be accessed from higher user levels; the higher the user level, the more functions are available. The current user level is displayed in the Title Bar across the top of the user interface screen.

The functions that can be accessed for each user level are as follows:

<table>
<thead>
<tr>
<th>User Level</th>
<th>Functions</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logout</td>
<td>View the main functions.</td>
<td>none</td>
</tr>
<tr>
<td>Operator</td>
<td>Start/Stop marking, select message, acknowledge alerts</td>
<td>op</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Create/Edit messages; Change Marking Parameters; Access to Editor and Save Editor</td>
<td>sv</td>
</tr>
<tr>
<td>Administrator</td>
<td>Edit most of the setup</td>
<td>Not published</td>
</tr>
<tr>
<td>Service</td>
<td>Access everything</td>
<td>Daily changing</td>
</tr>
</tbody>
</table>

Extended system parameter settings can only be changed after entering the Administrator password. This password is only known by employees authorised by Domino.

Note: If unauthorised changes are performed, the warranty will be invalidated.

Changing the passwords after the initial installation is recommended.

Security Mode

Home > Settings > Security > Setup

- Simple: A password has to be entered to login. Auto Login may be enabled.
- Advanced: A username and password have to be entered to login. Auto Login may be enabled. Set the user account expiry warning in days.
- Server Process: Security management is handled by an external server.
- Service: Service mode for service technicians only.
Add/Change User

(Advanced security mode only)

Home > Settings > Security > Users

A list of current Users is displayed. Select a User to change the User Name, Password or allocated Group.

To add a new User:
- Select Users > Add new user.
- Select inside the Username and Password fields to enable the keyboard and enter the required information.
- Select inside the Group field and allocate a group.
- Select Save to add the User.

Delete a User/Change Password

Home > Settings > Security > Users

- From Users, select the User to be deleted. (Advanced security mode only)
- Select Delete.

Use this area to change the password.

Groups

Home > Settings > Security > Groups

Add, setup and delete groups and assign user grants to a specified group.

Specify Password Policy

(Advanced security mode only)

Home > Settings > Security > Password Policy

Use this dialog to specify Password attributes such as Password expiry, number of characters and use of special characters.

Electronic Signature

(Advanced security mode only)

Home > Settings > Security > Electronic Signature

Define actions for which an electronic signature is needed to execute the action. A user has to enter username and password to confirm the actions selected for electronic signature.
Global Print Settings

Print Field Offset

*Home > Settings > Global Print Settings > Print Field Offset*

Offset for the print field in x and y direction in mm.

*Note:* The message must fit in the usable field, otherwise “Transformation failed” error will occur.

Message Options

*Home > Settings > Global Print Settings > Message Options*

- Override global parameter sets with locals: Use parameter sets which are defined within a message (local) or system wide (global) parameter sets. To ensure that the correct parameter set is used if there are local and global parameter sets with the same name.
- Load last message on startup: Automatically loads the last live message on startup and enables printing.

Marking Engine

*Home > Settings > Global Print Settings > Marking Engine*

Sets the Buffer Size (default value is 20).

At high printing speeds, with for example dynamic text objects such as counters or dates/times, the time and computer performance may be insufficient to recompile the new content to be printed. When using the DSP-side Buffering, a buffer is filled whenever it is possible.
Setup Aiming

*Home > Settings > Global Print Settings > Setup Aiming*

The aiming beam may be used for installation to see where the objects of the message are located on the product to print on.

Three options are implemented:
- Aiming beam disabled
- Aiming beam with laser power at the same time
- Aiming beam without laser power (aiming beam only).

Content/Shift Codes

*Home > Settings > Global Print Settings > Content*

The Setup Shifts screen allows the start time of each shift and a shift code to be set. Each shift continues until the start time of the next shift.

Click on +Add Row to add a new shift. Enter the start time and the shift code. Delete a shift by using the delete button.
Clocks/Dates

Home > Settings > Global Print Settings > Clock/Dates

- Julian Leap Day: February 29th is marked as either 060 or 366 depending on the setting for the Julian Leap Day.
- Expiration Update: Selects between midnight, after last shift and until first shift. After last shift updates the clocks at the end of the last shift even if that shift spans across midnight and into the next day. Until first shift updates the clocks at the beginning of the first shift even if the first shift occurs before midnight of the previous day.
- Week Begin Day: Selects a day of the week that is day 1 of each week.
- Time Granularity [ms]: Defines the time accuracy and time after which clocks are re-compiled. Every clock is re-compiled after the time set here. Computing power may be saved by setting a higher value for the granularity.
- Alpha Hours: Sets the string used by the Alpha Hour (h) time component. Defaults to A-Z (no I or O).
- Alpha Week Days: Sets the Alpha Day encoding string. Defaults to ABCDEFG. First letter corresponds to the “Week Begin Day”.
- Alpha Month Day: Sets the Alpha Month Day encoding string. Defaults to 1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ. First component corresponds to the “Week Begin Day”.
- Month Names: The Month Names can be edited in the Month Names dialogue box for later inclusion in a message.
- Month Short Names: The Month Short Names can be edited in the Month Short Names dialogue box for later inclusion in a message.
CREATING AND EDITING A MESSAGE

Add Text

- Select Messages > New Message or Settings > Message Editor to open the Message Editor.
- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.

The Add sub-menu displays.

- From the sub-menu select the Text icon.

Note: Change keyboards by selecting the appropriate Alternative Keyboard icon at the bottom of the text entry screen.

- Enter the required text using the keyboard and select the green tick icon when finished.
- To change text, select the text item and then the Keyboard icon on the Edit sub-menu.
- To change text parameters (Object Name, Position, Bold, Width, etc.), use the sub-menu (Font, Alignment) or select More…
- To delete an object, select the object and select the delete icon of the Edit menu.
- Activate the message for printing by sending it to the printer via the File menu.
**Unicode**

- Select Unicode (the icon will change to orange).
- Enter the Unicode value - the responding character (and value) will be displayed in the top right of the screen:

**Common Unicode Characters**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00A3</td>
<td>Pound (Sterling)</td>
<td>20AA</td>
<td>Shekel (Israel)</td>
</tr>
<tr>
<td>0024</td>
<td>Dollar (US)</td>
<td>20AB</td>
<td>Dong (Vietnam)</td>
</tr>
<tr>
<td>00A2</td>
<td>Cent (US)</td>
<td>20A2</td>
<td>Cruzerio (Brazil)</td>
</tr>
<tr>
<td>00A5</td>
<td>Yen (Japan)</td>
<td>20A6</td>
<td>Naira (Nigeria)</td>
</tr>
<tr>
<td>20AC</td>
<td>Euro</td>
<td>20A8</td>
<td>Rupee</td>
</tr>
<tr>
<td>20A1</td>
<td>Colon (Costa Rica)</td>
<td>20A9</td>
<td>Won (South Korea)</td>
</tr>
</tbody>
</table>

- Select ✔️ to enter this character into the text area and ✗ to cancel.
- Add more Unicode characters as required.
- Select Unicode again to revert back to the Text screen.

**Input Method Editor (IME)**

Entered in a similar manner to entering Unicode characters.

- Select the IME icon to display the IME entry area (the button will change to orange).
- Enter the required characters.
- Select the IME icon again to revert back to the text screen.
General Property Values

Object Name - Defines the name of the text object, which clearly identifies it for selection in the Object Selection window.

Object Name - Defines the name of the object.

X-position - Defines the left point of the object in mm.

Y-position - Defines the top point of the object in mm.

Width - Specifies the width of the object in mm (for text objects, this represents the size of each character).

Height - Specifies the height of the object in mm (for text objects, this represents the size of each character).

Hatching Mode -

Parameter Set - Defines the marking parameters for the object. Each object must have a parameter set assigned to it.

Rotation [º] - Rotates the object in clockwise or anti-clockwise direction, negative values give anti-clockwise rotation.

Y Angle [º] - Tilts the object into perspective. Positive and negative values in degrees are possible.

Horizontal - Alignment - Left, centre, right, none.

Vertical - Alignment - Top, centre, bottom, none.

Mirror x - Mirrors the object horizontally.

Mirror y - Mirrors the object vertically.

Locked - Object may not be edited.

Mark - Prevents/permits marking of the object. Useful for objects that are only used as a positional aid when creating an object. The Digital Input option is for special applications only and requires the Conditional and Mask values.

Reference Position X,Y - Displayed when the reference position is different to the X,Y position of an object.
Conditional Printing

For conditional printing the digital inputs needs to be configured. While the condition mask only specifies which inputs to look at, the condition value needs to be set according to the exact state the input shall have in order to mark the object.

Both condition mask and condition value are calculated by the sum of the binary representation value of the inputs to be used:

- User Input A - 1
- User Input B - 2
- User Input C - 4
- User Input D - 8
- User Input E - 16
- User Input F - 32
- User Input G - 64

Examples

- An object shall only be printed if user input A is high then mask=1/value=1
- An object shall only be printed if user input A is low then mask=1/value=0

An object shall only be printed if user input A is low and user input B is high then mask=3/value=2
Text object properties

Key functions for selecting and editing are the same as for the General object properties above.

Font - The font is selected from the Font drop down list.

Note: In addition to the fonts listed, other fonts can be delivered on request.

Kerning [%] - Sets the spacing between characters as a percentage of the character width. At more than 10%, the spacing between the characters increases. At less than 10%, the spacing between the characters decreases.

Line Spacing - Sets the line spacing after a special character.

Italics [°] - Rotates the vertical components of the characters independently by the input amount.

Proportional - “No” forces the same character width for all characters as defined under.

Alignment - Aligns the text left, right or centre, as selected from the drop down list.

Circular - Sets the text around a circle of the input radius in the direction set.

Inverse line flow - Used to speed up the scan process, where appropriate, by reversing the scan direction of the mirror.

Alternating line flow - Used to speed up the scan process, where appropriate, by alternately reversing the scan direction of the mirror.

Allow Empty Object - Text object may have no content.
Add a New Barcode

To add a barcode to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add Barcode icon and select the type and specification required from the list and editable text boxes.
- Use the Text, Variable, Edit Variable and Properties tabs to enter the barcode data.
- Select the green tick icon to insert the code into the message.
- Edit the barcode by highlighting the barcode within the message and using the sub-menu or by selecting More…
- Activate the message for printing by sending it to the printer via the File menu.

Barcode Object Properties

The property values are the same as the general property values and text property values.

- **Code Type** - Sets the code type, selected from the drop down menu.
- **Resolution (dpi)** - Specifies the resolution of the code in dots per inch.
- **Inverse** - Generates the inverse of the code. Necessary if the marking on the substrate is to be highlighted.
- **Check Digit** - Sets the code to include, or not include, a checksum from the drop down list.
- **Short Bar Length [%]** - Enables the human readable bar height of certain codes to be reduced, as shown below.
Add an Image

To insert an image into the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Image icon from the Add menu.
- An images folder stored in the printer will open.
- Browse for the required image.
- Select the green tick icon to insert the image.

Note: Monochrome Bitmap (*.bmp), DXF (*.dxf) (up to Version 12, information about 3-dimensional objects is discarded, fonts and labels are not supported) and Hewlett Packard Graphics Language HPGL (*.plt) black white graphic file formats are supported. Supported commands for HPGL import are: Arc Absolute, Arc Relative, Plot Absolute, Plot Relative, Pen Up, Pen Down

- Select the Move icon to move the copied item to the desired location within the message.
- Activate the message for printing by sending it to the printer via the File menu.

Use the File Manager (Home > Settings > File Manager) to copy an image from a USB device to the controller.

Image Object Properties

Force Reload - Tries to reload the imported graphic at message load. When a graphic has been updated the new graphic is loaded into the message.

Resolution (dpi) - Sets the resolution in dots per inch (dpi) of the lines that make up the graphic file.

Bitmap Algorithm - Specifies how the graphic is marked. Options include horizontal, vertical and outline.

Inverse - Generates the inverse of the graphic. Necessary if the marking on the substrate is to be highlighted. Has no effect in Outline mode.
DXF Import

DXF (Data eXchange Format) specifies an ASCII (plain text) file that allows the exchange of geometric data between different CAD systems as well as between a CAD system and an external program.

AutoCAD versions up to and including version 12 are supported, but any information about 3-dimensional objects is discarded. However, if your CAD program claims to use a DXF format of AutoCAD version 13 or higher, your drawing might be imported well if you do not use fancy objects like shapes, rays, multilines or ellipses.

Not supported are fonts and labels. Note that if there are dimension lines in the drawing, the dimension lines will be imported, however the dimension data is omitted since it is a label.

The major difference of DXF to HPGL files, which can be imported by Dynamark as well, is the need of interpreting the content of the DXF file: HPGL already defines the order of a plot, i.e. adjoining polygons and lines are plotted as one single polygon without interruption, whereas DXF just describes each entity without any information about their proximity.

Dynamark offers the possibility to find adjoining lines and assemble them to continuous polygons. However this is a time consuming process and decreases the total performance of the marking engine, but increases the performance of the print itself, i.e. calculating the print becomes slower whereas printing becomes faster.

Properties

Join Lines - Sometimes when an AutoCAD DXF file is imported, an object’s polylines are not joined. This means that each line on that object is its own line, and is not joined to the rest of the object. This happens when an object is created in AutoCAD using lines rather than polylines. By checking this option these lines are joined if the distance is lower than the defined join tolerance.

Join Tolerance - Maximum distance between two lines that are joined together when the option “Join Lines” is checked.
Add a Shape: Arc/Rectangle

To add a shape to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add Shape icon and select arc or rectangle.
- Specify the properties of the arc or rectangle.
- Select the green tick icon to insert the shape into the message.
- Edit the arc/rectangle by highlighting the shape within the message and using the sub-menu or by selecting More...
- Activate the message for printing by sending it to the printer via the File menu.

Arc Object Properties

The property values are the same as the general property values and text property values.

Angle - Sets the angle in degrees that the circle is to encompass. The default setting is 360.

Line Segments - Sets the number of line segments used in the circle. A higher number creates a more perfect circle. The minimum of three creates a triangle.

Border Lines - Sets the number of concentric circles or arcs used.

Object Name - Gives a unique name to the object.

Rectangle Object Properties

The property values are the same as the general property values and text property values.

Border Lines - Sets the number of rectangles.

Object Name - Enter a unique name for the object. This can be edited and modified.
Add a New Variable

Message or system variables may be added. Message variables may only be used in the message in which they have been created. System variables can be used in all messages.

- Message variables are created via Home > Settings > Message Editor > Add > Text > Add Variable.
- System variables are created via Home > Settings > Message Editor > File > Add/Edit Variable > Add Variable.

Note: System variables are referenced within message via a link. Insert a link into a message to use a global variable.

The following variables can be created and added to the message:

- Clock (message & system)
- Counter (message & system)
- Prompted Field (message only)
- Link (message only)
- Script (message only)
- Coding (message only)
- Shift Code (message only)
- Text Insert (message & system)
- Text Variable (message & system)
- Text Link (message only)

Notes: (1) System variables are emptied on a power cycle.
(2) All steps below are described for local variables as they are the same for global variables.
Add a New Clock

To add a new offset clock to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon
- From the sub-menu select the Add Text icon.
- Select +Variable >+Create New > Clock.
- The scope cannot be changed - use the File menu to create a global counter.
- Enter a name for the clock or use the default name and use the drop down lists to select the format.
- Select the required offset parameters (Days, Months, Years and/or Hours, Minutes, Seconds and/or Weeks) and add values using the keyboard. Select the green tick icon when each parameter is completed.
- Review the entered information and select the green tick icon if correct or press in the required field to add or change values.
- Select the green tick icon to enter the offset clock into the message.
- Activate the message for printing by sending it to the printer via the File menu.

Add a New Counter

To add a new counter to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon
- From the sub-menu select the Add Text icon.
- Select +Variable >+Create New > Counter.
- The scope cannot be changed - use the File menu to create a global counter.
- Enter a name for the counter and enter the Format String “N” for numerical and “A” for alpha characters.
- Select a Leading Character Mode from the drop down options: None, Blank or Custom. If a custom character is selected in the Leading Character box, enter the character required.
In the Step Control box, select the option required to activate the increment: Print Start. User Input (Rising Edge)- specify the User Input to be used. User Input (Falling Edge)- specify the User Input to be used.

In the External Reset box, select None, Mark Enable, Application Start, Message Load, User input Rising Edge, User input Falling Edge.

In the Counter Repeat box, enter the number of items to be marked before the counter increments (default value is ‘1’).

Step Size sets the increment value of the selected counter from 1 to 99999. The default value is ‘1’.

Set the current value in the selected alphanumeric format of the counter.

Set the start value in the selected alphanumeric format for the counter. If the start value is larger than the end value the counter will count backwards.

Set the end value in the selected alphanumeric format of the counter.

Edit, if required the Alpha Field String. To be used for the alpha designators in the counters. All alphanumeric characters are available for use in this string. The maximum string length is 26 characters. The default string is A to Z (including all characters).

Select an Ending Action: Select None, Disable, User Output or User output and disable. Select the User Output if activated.

If required, set a Batch Link to another counter when this counter has its end value and select the linked counter from the drop down list.

Review the entered information and select the green tick icon if correct or press in the required field to add or change values.

Select the green tick icon to enter the counter into the message.

Activate the message for printing by sending it to the printer via the File menu.
Add a New Prompted Field

Prompted text fields may be inserted into messages. The content of these text fields is entered in QuickStep after sending the message to the printer. The content format has to be specified when creating these text fields in a message in the Message Editor.

To add a new prompted field to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon
- From the sub-menu select the Add Text icon.
- Select +Variable > Create New > Prompted Field.
- Enter a name or use the default name for the prompted field object
- Set a default value in the format matching the input mask for the prompted field
- Enter a prompt which is displayed on screen when the data for the prompted field should be entered. (After sending the message to the printer)
- Select an input mask for the prompted field which specifies the type of content for the prompted field. Possible formats:

<table>
<thead>
<tr>
<th>Mask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Mandatory numeric character 0-9</td>
</tr>
<tr>
<td>9</td>
<td>Optional numeric character 0-9</td>
</tr>
<tr>
<td>L</td>
<td>Mandatory alpha character A-Z or a-z</td>
</tr>
<tr>
<td>?</td>
<td>Optional alpha character A-Z or a-z</td>
</tr>
<tr>
<td>A</td>
<td>Mandatory alphanumeric character 0-9, A-Z or a-z</td>
</tr>
<tr>
<td>a</td>
<td>Optional alphanumeric character 0-9, A-Z or a-z</td>
</tr>
<tr>
<td>C</td>
<td>Mandatory any character</td>
</tr>
<tr>
<td>c</td>
<td>Optional any character</td>
</tr>
<tr>
<td>#</td>
<td>Optional currency symbol €, $, £ or ¥</td>
</tr>
<tr>
<td>&amp;</td>
<td>Mandatory any character or space</td>
</tr>
</tbody>
</table>

- Review the entered information and select the green tick icon if correct or press in the required field to add or change values.
- Select the green tick icon to enter the prompted field into the message.
OPERATION

- Activate the message for printing by sending it to the printer via the File menu.

**Add a New Link**

To add a new link to the message:
- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable > Create New > Link.
- Enter a name or use the default name for the link object.
- Specify the source of the link, e.g. a counter or a clock or message content element. System variables are entered into a message via a link.
- Select the green tick icon to enter the offset clock into the message. The link object will have the same content as the source object.
- Activate the message for printing by sending it to the printer via the File menu.

**Add a New Script**

*Note: A script has to be copied to the scripts folder of the printer's disk to insert it into a message. This may be done via Home > Settings > File Manager*

To add a new script to the message:
- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable > Create New > Script.
- Specify the source for the script and the parameters needed within the script.
- Select the green tick icon to enter the offset clock into the message.
- Activate the message for printing by sending it to the printer via the File menu.
Add a New Coding

Coding allows a specified text file to be inserted into a message (.txt) and printed line by line.

**Note:** ASCII/Unicode (MTF8) text files are allowed for coding. (No Excel files etc.). Also, each line of the coding file must end with a carriage return (CR) and a Line Feed (LF).

**Note:** A coding file has to be copied to the coding folder of the printer’s disk to insert it into a message. This may be done via Home > Settings > File Manager

To add a new coding to the message:

- Go to the File menu and select via Coding the file or remote connection containing the information to print.
- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable >+Create New > Coding.
- Specify the parameters for coding.
- Select the green tick icon to enter the coding into the message.
- Activate the message for printing by sending it to the printer via the File menu.

Add a New Shift Code

- Define shift codes via Home > Settings > Global Print Settings > Content
- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable >+Create New > Shift.
- The shift code is inserted into the message.
- Activate the message for printing by sending it to the printer via the File menu.
Add a New Text Insert

Text inserts contain several text objects which are printed one after each other.

To add a new text insert to the message:

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable >+Create New > Text Insert.
- Enter a name or use the default name for the object.
- Select the mode type (action to print the next text insert of the list of text objects).

**Disabled** - Disables “Text Insert” functions.

**OEM Select** - Causes the marking of a text insert based on a binary representation placed on the OEM Select port.

**Timer** - Causes the change of marking a text insert after a fixed elapsed time in seconds.

**Trigger** - Causes the increment of a text insert using either a printstart trigger or user input as chosen in the “trigger” option.

**Level** - Causes the marking of a text insert based on the state of the selected input. If the selected user input state is active, the insert will be marked. Otherwise, its place will be filled with space characters.

Depending on the Mode selection chosen, the following parameters will need setting:

**Increment Interval** - Time interval between each insert line.

**Trigger Timer** - Triggers the insert line by using either a printstart signal or user input (rising and falling edge signals).

**Input** - Selects which user input signal is used (not for printstart).

**Initial Text Index** - Index of the initial text.

**Auto Repeat** - Number of insert repeats before the insert will increment.

- Choose a fixed or variable length mode for the text inserts. Specify the length of the text inserts when fixed length is chosen.
- Enter the text objects via “Text to Insert” > View into the list of text objects.
- Select the green tick icon to enter the offset clock into the message. The text inserts object will have the same content as the source object.
- Activate the message for printing by sending it to the printer via the File menu.
Add a New Text Variable

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable > Create New > Text Variable.
- Enter a name or use the default name for the object.
- Enter a value for the variable.
- Select the green tick icon to enter the coding into the message.
- Activate the message for printing by sending it to the printer via the File menu.

Add a New Text Link

- Press on the screen within a specific area of the Message Editor where you require the item to appear. A cross hair will appear at this location.
- Select the Add icon.
- From the sub-menu select the Add Text icon.
- Select +Variable > Create New > Text Link.
- Select the source text object for the text link.
- Select the character mode: Line: To select the complete content of the text object to which it is linked to. Range: To select the specified content of the text object to which it is linked to. Specificity offset and length of the source text object to insert into the text link.
- Select the green tick icon to enter the text link into the message.
- Activate the message for printing by sending it to the printer via the File menu.
Undo / Redo

Undo re redo the last editing steps in the message editor including change of settings or parameter settings.

Note: Creating a new message clears the undo cache - no undo to the last message is possible.

File

New Message - Creates a new message.
Save - Saves the current message in a selected message store.
Save as - Saves the current message with a given name in a selected messages store.
Coding - Selects a source for the coding variable.
Laser Parameters - Create, delete and edit laser parameter sets
Global Variables - Create global variables
Message Properties - Message settings overwrites system settings of Fields, Mark on the Fly, Vector Sorting and activate usable fields. Also enables the user to activate Optical Correction, Tube Distortion and PN Transformation.
Send to Printer - sends the current message to the printer and activates it for printing.
Parameter Set

- **New** - Create a new parameter set
- **Duplicate** - Clones a parameter set
- **Edit** - Edits a parameter set
- **Delete** - Deletes a parameter set

**Scope** - Selects if the parameter set is a system parameter set or a message parameter set for one message only. Message parameter sets are saved together with the message.

**Name** - Name of the parameter set.

**Laser Power** - Sets the percentage for the optical output of the CO2 laser.

**Mark Speed** - Sets the speed to be used during marking. If the mark appears to be faint, reduce this value (note that this will increase the marking time).

**Jump Speed** - Sets the speed to be used between marked vectors (speed at which laser jumps from one vector to the next). If an object consists of many short polygon strokes, then a large value will make the mark appear distorted.

**Maximal Vector Length** - Sets the maximum length of a vector in mm. Longer vectors are sub-divided into individual vectors of this length. Ensures that straight lines and curves are read in an identical axis, thereby standardising the type face. Zero is considered infinite (vector not sub-divided).

**Mark Delay** - Delay in marking after a “Mark” command. Mark-Delay too short: even though the mirrors have not yet reached the end positions of a vector, the command is already given to scan the next vector. Result: the end of the vector is bent towards the subsequent vector.

Mark-Delay too long: has no negative effect on the visible scanning result. The time required increases, however.

**Jump Delay** - Delay in marking after a “Jump” command.

Jump-Delay too short: the vector following a jump command is already marked at the end position of the jump-vector during the necessary settling time of the mirrors. Result: an indent or overshoot becomes visible.

Jump-Delay too long: has no negative effect on the visible scanning result. The time required increases, however.
**Polygon Delay** - Delay between two “Mark” commands.

Polygon-Delay too short: the vector following a vector is already carried out, even though the mirrors have not yet reached the end position of the previous vector. Result: the corners of a polygon outline are rounded off.

Polygon-Delay too long: the mirrors are greatly slowed down or even come to a stop at the end position of a vector. Result: burn-in points at the affected vector ends.

**Laser-Off Delay** - Delay in switching the laser off.

Laser-Off-Delay too short: the laser is already switched off after a “Mark” command, even though the mirrors have not yet reached the vector end position. Result: the vectors are not marked completely.

Laser-Off-Delay too long: the laser is switched off too late after a “Mark” command. The laser is still on, even though the mirrors are already being significantly slowed down or have already stopped. Result: burn-in effects at the end points.

**Laser-On Delay** - Delay in switching the laser on.

Laser-On-Delay too short: even though the mirrors have not yet reached the required angular velocity at the beginning of a “Mark” command, the laser is already switched on. Result: burn-in effects at the starting points.

Laser-On-Delay too long: the laser is switched on too late at the beginning of a “Mark” command. Result: the vectors are not marked from the starting point.

**Step Period** - Time period for data update of DSP in scanning head.
## Standard Parameters

**D120i**

Default parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>D120 i-Tech 10mm Scan head</td>
</tr>
<tr>
<td>StepPeriod [ms]</td>
<td>30</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>100</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>100</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>20</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>110</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>70</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0.25</td>
</tr>
<tr>
<td>LaserPower [%]</td>
<td>90</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>7000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>6000</td>
</tr>
</tbody>
</table>

Parameter ranges:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>D120 i-Tech 10mm Scan head</td>
</tr>
<tr>
<td>StepPeriod [ms]</td>
<td>10..100</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>30..500</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>30..500</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0..100</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>100..16000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>100..16000</td>
</tr>
</tbody>
</table>
D320i

Default parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td>StepPeriod [ms]</td>
<td>30</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>100</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>100</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>20</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>110</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>80</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0.25</td>
</tr>
<tr>
<td>LaserPower [%]</td>
<td>95</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>7000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>6000</td>
</tr>
</tbody>
</table>

Parameter ranges:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td>StepPeriod [ms]</td>
<td>10..100</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>10..500</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>10..500</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0..100</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>100..16000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>100..16000</td>
</tr>
</tbody>
</table>
### D620i

Default parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td>StepPeriod [ms]</td>
<td>10</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>110</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>100</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>20</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>120</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>80</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0.2</td>
</tr>
<tr>
<td>LaserPower [%]</td>
<td>96</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>7000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>5000</td>
</tr>
</tbody>
</table>

Parameter ranges:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Laser System</th>
</tr>
</thead>
<tbody>
<tr>
<td>StepPeriod [ms]</td>
<td>10..100</td>
</tr>
<tr>
<td>JumpDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>MarkDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>PolygonDelay [ms]</td>
<td>0..500</td>
</tr>
<tr>
<td>LaserOffDelay [ms]</td>
<td>30..500</td>
</tr>
<tr>
<td>LaserOnDelay [ms]</td>
<td>30..500</td>
</tr>
<tr>
<td>MaxVectorLength [mm]</td>
<td>0..100</td>
</tr>
<tr>
<td>JumpSpeed [bit/ms]</td>
<td>1000..11000</td>
</tr>
<tr>
<td>MarkSpeed [bit/ms]</td>
<td>100..17000</td>
</tr>
</tbody>
</table>
**Edit**

*Edit menu for a text object*

**Edit Text** - Opens the keyboard to edit the text content  
**Select Font** - Opens the list of available fonts to select a font  
**Alignment** - Sets the alignment of the object  
**Edit Object Properties** - Allows editing the properties of the object  
**Delete Object** - Deletes the selected object

**Add**

**Move**

Select an object in the editor by clicking on it and move it in the desired direction by clicking on the arrow icons.

*Note: Drag and drop can also be used. Select and hold the item within the message and move it to the desired location.*
Zoom

To view the item(s) in the Message field, or the whole Message field in a different size, select the item(s) and then select the appropriate button from the above toolbar:

- Incrementally zoom in on the message area.
- Incrementally zoom out of the message area.
- Fit whole message height to area.
- Fit whole message width to area.
- Zoom to 100% (actual size) of Message.
- Zoom selected item to fit into message area.

Re-order Visual Items

Sets the order of objects to print.
Select an object of the list and use the arrows to change the order.

Item Selection List

Selects multiple or all objects of a message. Select the items of the list to be selected. Or click on “Select all” to select all objects. Click on “Clear Selection” to have no object selected.

Resize

Resize an object by selecting it and dragging the red mark of the object.
MESSAGE STORE AND FILE MANAGEMENT

Selecting an Existing Message

Note: Where no message is selected for printing, no live message will be displayed in the Home screen.

• Select the Messages button to open the Message Store.
• Select the required message from the list.
• Choose to Edit, Preview or Send to Print.

Note: Send to Print will revert to the Home screen. The selected message will then be displayed.

File Manager

Home > Settings > File Manager

File Manager is a useful way of reviewing and organising stored messages, images and scripts.

Using File Manager it is easy to edit files, create new folders and copy content between folders.

New Store: Create a new store for messages, images and scripts.

Note: A new message store can only be created in the messages folder.

Edit:

• Rename
• Copy
• Cut
• Delete
• Details

Paste: Used with the Copy/Cut commands to add files into folders.
BACKUP AND RESTORE

Backup

Home > Settings > Backup & Restore > Backup

A backup can be saved to the printer’s disk, to the TouchPanel or to the BCP7 controller connected USB device.

Navigate to the folder to which you wish to copy the backup files.

The following backup types can be selected:

- Messages: All messages of all stores
- Fonts: All fonts
- Graphic Files: All graphic files
- Configuration Files: System configuration files
- Security Setup: User and group setup
- Application Log: All log files
- Operating System: The operating system of the printer
- Binary Files: Driver plug-ins, firmware, correction marix

Files will be copied to USB/Backup on the USB device. A prompt will display when the back-up is complete.

A backup copied to the USB device can be used to restore to the same printer, another printer or used for information.

Restore

Home > Settings > Backup & Restore > Restore

CAUTION: If restoring information to a different printer, it is essential that the printer hardware is of the same version level. Please contact Domino for advice.

Insert the USB device containing the backup files into the USB port of the TouchPanel or into the USB port of the BCP7 controller.

Navigate to the folder containing the backup files and click on Restore.

Update

Home > Settings > Backup & Restore > Update

Updates may be applied to the system via this option. Select the update file via navigating to its path.
Defaults

Home > Settings > Backup & Restore > Defaults

Restores the default factory settings. Messages will not be deleted.

PRINTER STATUS

Home > Printer Status

Shows statistics about the current live (printing) message and printer data.

Data displayed includes:

- Message name and messages tore used
- Print speed
- Print duration
- Products coded
- Maximum print and external update duration
- Maximum compile time
- Numbers of vectors and polygons in the current live message
- Controller and laser runtime
- Print count

ADVANCED SETTINGS

Home > Settings > Advanced

CAUTION: Setup for trained users and service technicians only.
The system may be damaged by incorrect settings.
All warranty is lost when the system is damaged by incorrect settings.

Laser Parameters

Home > Settings > Advanced > Laser Parameters

Setup of laser parameter limits.

Set the following special laser parameters:

- Period Time
- Standby Period
- Standby Pulse

Activate the laser test mode and set the parameters:

- Period Time
- On Pulse Time

Set the period time for the laser cold start.
OPERATION

Configuration Files
Home > Settings > Advanced > Configuration Files
Direct access to the configuration files of the marking software.

Install Options
Home > Settings > Advanced > Install Options
Setup the options installed to the laser printer:
- Air Kit
- Chiller
- Vacuum
- Shutter Option
- Aiming Option

DIAGNOSTICS
Home > Settings > Diagnostics

Status
Home > Settings > Diagnostics > Status
Shows a hardware status overview:
- Cabinet Temperature of the BCP7 controller
- SBC Board temperature
- Scanner Voltage
- Laser DC Voltage
- Cooling Frequency
- OEM Value

Logs
Home > Settings > Diagnostics > Logs
The software maintains several chronological records of the D-Series user activity.
Audit Trail Log

The Audit Trail Log stores an action history of each laser status event by time, date, and user status. For example, users logging in and out, marking started and stopped, etc.

Status Log

Chronological list of all status messages. Get details by clicking on the status message.

ALERT CONFIGURATION

Home > Settings > Alert Configuration

CAUTION: Setup for trained users and service technicians only. The system may be damaged by incorrect settings. All warranty is lost when the system is damaged by incorrect settings.

Configure Alerts

Home > Settings > Alert Configuration > Configure Alerts

Opens the status configuration editor.

Ranged Alerts

Home > Settings > Alert Configuration > Ranged Alerts

Sets the warning and error level for the audit trial log export. The audit trail has to be exported at least after 183 days of use. The audit trail log is cleaned after export.

IO PORT

Home > Settings > IO Port

Assignment

Home > Settings > IO Port > Assignment

Assign the outputs for

- Print Done
- Printer Software Ready

Assign the inputs for

- Message Select Strobe
- Text Insert Strobe
- Message Select / Text Insert Data
Test

Home > Settings > IO Port > Test

CAUTION: Setup for trained users and service technicians only.
The system may be damaged by incorrect settings.
All warranty is lost when the system is damaged by incorrect settings.

Shows the status of inputs and outputs and allows setting / re-setting of inputs and outputs.

Message Select

Home > Settings > IO Port > Message Select

Messages may be activated for printing by a combination of input signals and a strobe signal via the user port. The input signals have to be set before sending the message select strobe signal to the controller.

Select the message store and the messages to use.

To activate a message the sum of the binary representation value of the inputs is used:

- User Input A - 1
- User Input B - 2
- User Input C - 4
- User Input D - 8
- User Input E - 16
- User Input F - 32
- User Input G - 64

Examples

If message 0 shall be printed set all user inputs low.
If message 1 shall be printed set user input A high and all other low.
If message 3 shall be printed set user input A and B high and all other low.
If message 13 shall be printed set user input A, C and D high and all other low.
PRINTER NETWORK

Home > Settings > Printer Network

CAUTION: Setup for trained users and service technicians only.
The system may be damaged by incorrect settings.
All warranty is lost when the system is damaged by incorrect settings.

Ethernet

Home > Settings > Printer Network > Ethernet
Setup of the Ethernet connection to the printer.

Multi-Head

Home > Settings > Printer Network > Multi-Head
Setup of the optional Multi-Head functionality. A reboot is required after selecting this feature.
The Multi-Head option allows operating several controllers and lasers using just a single interface, both for connected machines and for the operator.
The controllers are connected to a chain and all communication and operation is done via the master controller of this chain.
One can configure multiple systems to not print synchronously. One can then still use a common TouchPanel and a common interlock circuit but use separate trigger signals for each laser. This is useful if you have multiple parallel but independent production lines with one housing for multiple lasers.

Serial

Home > Settings > Printer Network > Serial
Setup of the optional serial RS232 interface of the printer.

Advanced

Home > Settings > Printer Network > Advanced
Setup of the Dynamark interface which may be used to send commands directly to the printer.
SYSTEM INFORMATION

Home > Settings > System Information

Overview

Home > Settings > System Information > Overview
Shows the following:

- Printer model
- IP Address of the printer
- ID of the printer
- System Date
- System Time

Software Versions

Home > Settings > System Information > Software Versions
Shows an overview of the software versions installed on the printer.

Hardware Versions

Home > Settings > System Information > Hardware Versions
Shows information about the controller’s hardware.
USER INTERFACE

Home > Settings > User Interface

Printer Connection

Home > Settings > User Interface > Printer Connection
Select the connection method and setup the connection to the printer.

Language & Keyboard

Home > Settings > User Interface > Language & Keyboard
Set: user interface:
- Language
- Keyboard Layout
- IME Scheme for the keyboard
- Primary Currency

Network

Home > Settings > User Interface > Network
Configuration of the TouchPanel.

Versions Information

Home > Settings > User Interface > Versions Information
Shows information about the Quickstep user interface.
INITIAL SETUP WIZARD

Home > Settings > Initial Setup Wizard

Wizard for setup of the printer:

- Select language and printer name
- Printer type
- Optical correction
- Print field
- Orientation
- Usable print field
- Product movement
- Encoder scale
- Vector sorting
# PART 4 : TECHNICAL REFERENCE

## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTROL UNIT WITH TOUCHPANEL</td>
<td>4-3</td>
</tr>
<tr>
<td>D320i IP43 AND IP55 CONTROLLER</td>
<td>4-3</td>
</tr>
<tr>
<td>D620i CONTROLLER WITH TOUCHPANEL</td>
<td>4-4</td>
</tr>
<tr>
<td>LASER UNIT WITH SCANNER HEAD</td>
<td>4-4</td>
</tr>
<tr>
<td>OPTIONS FOR USE</td>
<td>4-5</td>
</tr>
<tr>
<td>D-Series Laser Marking System</td>
<td>4-5</td>
</tr>
<tr>
<td>PERFORMANCE DATA</td>
<td>4-5</td>
</tr>
<tr>
<td>CONTROLLER TYPES</td>
<td>4-6</td>
</tr>
<tr>
<td>SPECIFICATION</td>
<td>4-7</td>
</tr>
<tr>
<td>D-Series Laser Marking System (10 Watt Versions)</td>
<td>4-7</td>
</tr>
<tr>
<td>D-Series Laser Marking System (30 Watt Versions)</td>
<td>4-8</td>
</tr>
<tr>
<td>D-Series Laser Marking System (60 Watt Versions)</td>
<td>4-9</td>
</tr>
<tr>
<td>INSTALLATION DIMENSIONS</td>
<td>4-10</td>
</tr>
<tr>
<td>TOUCHPANEL</td>
<td>4-22</td>
</tr>
<tr>
<td>TOUCHPANEL DIMENSIONS</td>
<td>4-23</td>
</tr>
</tbody>
</table>
CONTROL UNIT WITH TOUCHPANEL

D320i IP43 AND IP55 CONTROLLER

IP43 controller version

IP55 controller version
TECHNICAL REFERENCE

D620i CONTROLLER WITH TOUCHPANEL

LASER UNIT WITH SCANNER HEAD

IP65 laser version

IP43 laser version

Lens Assembly

Scanner Head

D-Series laser head
OPTIONS FOR USE

The D-Series Laser Marking Systems are suited for directly marking objects by material removal, or by changing the colour of the material. All painted, printed or anodised materials can be marked by material removal, giving the marking contrast. We highly recommended that the technical aspects of individual applications are discussed with the manufacturer or the distributor.

D-Series Laser Marking System

The following materials can be marked with a CO₂ laser:
- Painted or coated metals
- Glass
- Ceramics
- Cardboard
- Various plastics.

PERFORMANCE DATA

The D-Series laser marking system can be used with indexed, continually running, or intermittently running batch processing packaging machines. The laser marking system operates automatically and adapts to the speed of the object to be marked. This always guarantees marking of equal quality, independent of the respective movement of the production line. The text or the logo can easily be changed at any time via the provided user interface software.

The marking speed depends on the following parameters:
- Number of lines and characters, size and complexity of characters
- The speed at which the marked object is run
- Size and spacing of the marked objects

This part of the manual contains an overview of the D-Series marking system and its field of application. Choose the right system by considering the surface condition of the materials to be marked and the type and complexity of the marking.
## CONTROLLER TYPES

<table>
<thead>
<tr>
<th>Controller Type</th>
<th>D320i</th>
<th>D620i</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Electrical Requirements:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mains Power:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>90-264VAC</td>
<td>90-264VAC</td>
</tr>
<tr>
<td>Frequency</td>
<td>47Hz-63Hz</td>
<td>47Hz-63Hz</td>
</tr>
<tr>
<td>max. Power Consumption</td>
<td>1050VA</td>
<td>2000VA</td>
</tr>
<tr>
<td>Laser Power:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>30V DC</td>
<td>48V DC</td>
</tr>
<tr>
<td>max. Current</td>
<td>5 A</td>
<td>22 A</td>
</tr>
<tr>
<td>IP 43 Enclosure:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimensions (L x W x H) [mm]</td>
<td>371x430x154</td>
<td>371x430x310</td>
</tr>
<tr>
<td>Cooling</td>
<td>fan cooled</td>
<td>fan cooled</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>5° to 40° C (41° to 100°F)</td>
<td>5° to 40° C (41° to 100°F)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Controller Type</th>
<th>D320i IP</th>
<th>D620i IP</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP 55 Enclosure:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimensions (L x W x H) [mm]</td>
<td>400x541x229</td>
<td>400x541x458</td>
</tr>
<tr>
<td>Cooling</td>
<td>fan cooled</td>
<td>fan cooled</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>5° to 40° C (41° to 100°F)</td>
<td>5° to 40° C (41° to 100°F)</td>
</tr>
<tr>
<td>Environment Humidity</td>
<td>max. 90% RH, non condensing</td>
<td>max. 90% RH, non condensing</td>
</tr>
</tbody>
</table>
## SPECIFICATION

D-Series Laser Marking System (10 Watt Versions)

<table>
<thead>
<tr>
<th>D-Series Models</th>
<th>D120i 10mm or 15mm Scan Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Power</td>
<td>10W (approx. 8W for Blue tube option @ wavelength of 9.3μm)</td>
</tr>
<tr>
<td>Laser Peak Power $P_0$</td>
<td>30W</td>
</tr>
<tr>
<td>Laser Type</td>
<td>Sealed-Off CO2 Laser</td>
</tr>
<tr>
<td>Wavelength</td>
<td>10.6μm typical (9.3μm as Blue tube option available)</td>
</tr>
<tr>
<td>Duty Cycle*</td>
<td>100%</td>
</tr>
<tr>
<td>Maximum Laser On Time</td>
<td>No limit</td>
</tr>
<tr>
<td>Code Types</td>
<td>Logos, bar codes, 2D codes, graphics, text, etc.</td>
</tr>
<tr>
<td>Characters per second*</td>
<td>800*</td>
</tr>
<tr>
<td>Product Line Speed*</td>
<td>200m/min* 650ft/min*</td>
</tr>
<tr>
<td>Character Height</td>
<td>0.6mm - field size (0.02in - field size)</td>
</tr>
<tr>
<td>Focal Length</td>
<td>i-Tech 10: 80, 100, 120, 150, 200, 250mm; i-Tech 15: 250, 325, 450mm</td>
</tr>
<tr>
<td>Marking Field</td>
<td>i-Tech 10: 58 x 58, 68 x 68, 84 x 84, 102 x 102, 136 x 136, 180 x 180mm; i-Tech 15: 200 x 254, 262 x 334, 356 x 452mm</td>
</tr>
<tr>
<td>Fonts</td>
<td>24 fonts, multi-language including full Unicode</td>
</tr>
<tr>
<td>Scan Head</td>
<td>i-Tech Scan Head, mountable in various orientations including axial and radial</td>
</tr>
<tr>
<td>Laser Head</td>
<td>Stainless steel and anodised aluminium construction</td>
</tr>
<tr>
<td>Dimensions **</td>
<td>681 x 140 x 180 [mm]** 26.8 x 5.5 x 7.1 [in]**</td>
</tr>
<tr>
<td>Weight</td>
<td>16.5 kg (36.4 lbs)</td>
</tr>
<tr>
<td>Operating Temp.</td>
<td>5° to 40° C (41° to 104° F)</td>
</tr>
<tr>
<td>Environmental Humidity</td>
<td>Max. 90% RH, non-condensing</td>
</tr>
<tr>
<td>Cooling</td>
<td>Air, Compressed Air</td>
</tr>
</tbody>
</table>

*Characters per second and production line speeds are substrate and code dependent

**Dimensions measured overall for shortest version
# D-Series Laser Marking System (30 Watt Versions)

<table>
<thead>
<tr>
<th>D-Series Models</th>
<th>D320i 10mm or 15mm Scan Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Power</td>
<td>30W (approx. 20W for Blue tube option @ wavelength of 9.3μm, approx 28W for Red tube option @ wavelength of 10.2μm,)</td>
</tr>
<tr>
<td>Laser Peak Power $P_0$</td>
<td>75W</td>
</tr>
<tr>
<td>Laser Type</td>
<td>Sealed-Off CO₂ Laser</td>
</tr>
<tr>
<td>Wavelength</td>
<td>10.6μm typical (9.3μm as Blue tube and 10.2μm as Red tube option available)</td>
</tr>
<tr>
<td>Duty Cycle*</td>
<td>100%</td>
</tr>
<tr>
<td>Maximum Laser On Time</td>
<td>No limit</td>
</tr>
<tr>
<td>Code Types</td>
<td>Logos, bar codes, 2D codes, graphics, text, etc.</td>
</tr>
<tr>
<td>Characters per second*</td>
<td>1500*</td>
</tr>
<tr>
<td>Product Line Speed*</td>
<td>400m/min*</td>
</tr>
<tr>
<td>Character Height</td>
<td>0.6mm - field size (0.02in - field size)</td>
</tr>
<tr>
<td>Focal Length</td>
<td>i-Tech 10: 80, 100, 120, 150, 200, 250mm; i-Tech 15: 250, 325, 450mm</td>
</tr>
<tr>
<td>Marking Field</td>
<td>i-Tech 10: 58 x 58, 68 x 68, 84 x 84, 102 x 102, 136 x 136, 180 x 180mm; i-Tech 15: 200 x 254, 262 x 334, 356 x 452mm</td>
</tr>
<tr>
<td>Fonts</td>
<td>24 fonts, multi-language including full Unicode</td>
</tr>
<tr>
<td>Scan Head</td>
<td>i-Tech Scan Head, mountable in various orientations including axial and radial</td>
</tr>
<tr>
<td>Laser Head</td>
<td>Stainless steel and anodised aluminium construction</td>
</tr>
<tr>
<td>Dimensions (L x W x H)**</td>
<td>784 x 140 x 180 [mm]** (32.4 x 5.5 x 7.1 [in])**</td>
</tr>
<tr>
<td>Weight</td>
<td>22 kg (48.5 lbs)</td>
</tr>
<tr>
<td>Operating Temperatures</td>
<td>5º to 40º C (41º to 104º F)</td>
</tr>
<tr>
<td>Environmental Humidity</td>
<td>Max. 90% RH, non-condensing</td>
</tr>
<tr>
<td>Cooling</td>
<td>Air, Compressed Air</td>
</tr>
</tbody>
</table>

*Characters per second and production line speeds are substrate and code dependent

**Dimensions measured overall for shortest version
# D-Series Laser Marking System (60 Watt Versions)

<table>
<thead>
<tr>
<th>D-Series Models</th>
<th>D620i 10mm or 15mm Scan Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Power</td>
<td>60W (approx. 60W for Blue tube option @ wavelength of 9.3μm)</td>
</tr>
<tr>
<td>Laser Peak Power $P_0$</td>
<td>120W</td>
</tr>
<tr>
<td>Laser Type</td>
<td>Sealed-Off CO$_2$ Laser</td>
</tr>
<tr>
<td>Wavelength</td>
<td>10.6μm typical (9.3μm as Blue tube as option available)</td>
</tr>
<tr>
<td>Duty Cycle*</td>
<td>100%</td>
</tr>
<tr>
<td>Maximum Laser On Time</td>
<td>No limit</td>
</tr>
<tr>
<td>Code Types</td>
<td>Logos, bar codes, 2D codes, graphics, text, etc.</td>
</tr>
<tr>
<td>Characters per second*</td>
<td>2000*</td>
</tr>
<tr>
<td>Product Line Speed*</td>
<td>600m/min*</td>
</tr>
<tr>
<td>Character Height</td>
<td>0.6mm - field size (0.02in - field size)</td>
</tr>
<tr>
<td>Focal Length</td>
<td>i-Tech 10: 80, 100, 120, 150, 200, 250mm;</td>
</tr>
<tr>
<td></td>
<td>i-Tech 15: 250, 325, 450mm</td>
</tr>
<tr>
<td>Marking Field</td>
<td>i-Tech 10: 58 x 58, 68 x 68, 84 x 84, 102 x 102, 136 x 136, 180 x 180mm</td>
</tr>
<tr>
<td></td>
<td>i-Tech 15: 200 x 254, 262 x 334, 356 x 452mm</td>
</tr>
<tr>
<td>Fonts</td>
<td>24 fonts, multi-language including full Unicode</td>
</tr>
<tr>
<td>Scan Head</td>
<td>i-Tech Scan Head, mountable in various orientations including axial and radial</td>
</tr>
<tr>
<td>Laser Head</td>
<td>Stainless steel and anodised aluminium construction</td>
</tr>
<tr>
<td>Dimensions (L x W x H)**</td>
<td>846.1 x 140 x 180 [mm]**</td>
</tr>
<tr>
<td></td>
<td>(33.4 x 5.5 x 7.1 [in])**</td>
</tr>
<tr>
<td>Weight</td>
<td>27.3 kg (60.2 lbs) (air cooled)</td>
</tr>
<tr>
<td></td>
<td>30.0 kg (66.2 lbs) (water cooled, without coolant))</td>
</tr>
<tr>
<td>Operating Temperatures</td>
<td>5º to 40º C (41º to 104º F)</td>
</tr>
<tr>
<td>Environmental Humidity</td>
<td>Max. 90% RH, non-condensing</td>
</tr>
<tr>
<td>Cooling</td>
<td>Air, Water</td>
</tr>
</tbody>
</table>

*Characters per second and production line speeds are substrate and code dependent

**Dimensions measured overall for shortest version
INSTALLATION DIMENSIONS

Dimensions: D-Series Control Unit (10W to 30W systems) with elbows fitted for 19" rack mounting (optional)
Dimensions: D-Series Control Unit (10W to 30W systems)
IP55 version
D-Series Dimensions: Control Unit (60W systems) with elbows fitted for 19" rack mounting (optional)
Dimensions: D-Series Control Unit (60W systems) IP55 version
Dimensions: D-Series 10, 30 Watt Laser Head with i-Tech 10mm scanner (down left), air cooled
Dimensions: D-Series 10, 30 Watt Laser Head
with i-Tech 10mm scanner (down left), compressed air cooled
Dimensions: D-Series 10, 30 Watt Laser Head with i-Tech 15mm scanner (axial down), air cooled
Dimensions: D-Series 60 Watt Laser Head with i-Tech 10mm scanner (down left), air cooled
Dimensions: D-Series 60 Watt Laser Head 
with i-Tech 10mm scanner (down left), water cooled
D-Series
Scanner Long Mount Orientations
D-Series
Scanner Short Mount Orientations
D-Series
Scanner RapidScan Orientations
(not available for i-Tech 15 scanner)
TOUCHPANEL

Note: The TouchPanel can be supplied as an optional user interface.

Technical Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>10.4 inch SVGA full colour touch screen</td>
</tr>
<tr>
<td>Operating System</td>
<td>MS Windows CE 6</td>
</tr>
<tr>
<td>Touchscreen Dimensions (mm)</td>
<td>307(W) x 232(H) x 75(D)</td>
</tr>
<tr>
<td>Touchpanel IP Rating</td>
<td>Designed to IP55</td>
</tr>
<tr>
<td>Mounting Accessories</td>
<td>Full range of brackets</td>
</tr>
<tr>
<td>Temperature</td>
<td>5 - 45 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>10 - 90% none-condensing</td>
</tr>
<tr>
<td>Electrical</td>
<td>Input AC: 100 - 240VAC, 0.7A, 50/60Hz</td>
</tr>
<tr>
<td></td>
<td>Input DC: 24Vdc, 20W over Ethernet</td>
</tr>
<tr>
<td>Weight</td>
<td>2.85 Kg</td>
</tr>
<tr>
<td>Mounting</td>
<td>VESA 75 Mounting standard</td>
</tr>
<tr>
<td>Ethernet Cable</td>
<td>5 metre and 10 metre available</td>
</tr>
</tbody>
</table>

Note: The TouchPanel may be powered via external power via the mains in connector or via the ethernet connector when connected to a BCP7 controller. The mains switch only switches the power of the TouchPanel when external power is connected to the TouchPanel.
TOUCHPANEL DIMENSIONS

TOUCHPANEL POWER CABLE
# PART 5 : MAINTENANCE AND FAULT FINDING

## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHECKING FANS AND AIR VENTS</td>
<td>5-3</td>
</tr>
<tr>
<td>Control Unit and Laser Head Fans</td>
<td>5-3</td>
</tr>
<tr>
<td>Laser Head Air Vents</td>
<td>5-3</td>
</tr>
<tr>
<td>CLEANING THE LENS</td>
<td>5-3</td>
</tr>
<tr>
<td>GENERAL CLEANING</td>
<td>5-4</td>
</tr>
<tr>
<td>FAULT FINDING</td>
<td>5-4</td>
</tr>
<tr>
<td>STATUSES MESSAGES AND SUGGESTED ACTIONS</td>
<td>5-5</td>
</tr>
<tr>
<td>System Status Messages</td>
<td>5-5</td>
</tr>
<tr>
<td>REPLACING THE LENS</td>
<td>5-19</td>
</tr>
<tr>
<td>CHANGING THE FUSES</td>
<td>5-20</td>
</tr>
<tr>
<td>Main Power Fuses F1 and F2</td>
<td>5-20</td>
</tr>
<tr>
<td>Laser Power Supply Fuse, Label F3</td>
<td>5-20</td>
</tr>
<tr>
<td>CHANGING THE PC-CMOS SETUP BATTERY</td>
<td>5-21</td>
</tr>
<tr>
<td>HIGH VOLTAGE DURING MAINTENANCE</td>
<td>5-21</td>
</tr>
<tr>
<td>STATUS LEDS</td>
<td>5-22</td>
</tr>
<tr>
<td>WATER CHILLER</td>
<td>5-23</td>
</tr>
<tr>
<td>TOUCHPANEL BUFFER BATTERY</td>
<td>5-23</td>
</tr>
<tr>
<td>FUME EXTRACTION SYSTEM</td>
<td>5-25</td>
</tr>
<tr>
<td>General Notes</td>
<td>5-25</td>
</tr>
<tr>
<td>Recommended Routine Maintenance</td>
<td>5-25</td>
</tr>
<tr>
<td>Daily</td>
<td>5-25</td>
</tr>
<tr>
<td>Weekly</td>
<td>5-25</td>
</tr>
<tr>
<td>Annual</td>
<td>5-25</td>
</tr>
<tr>
<td>Changing Filter Bags</td>
<td>5-26</td>
</tr>
<tr>
<td>Changing Main Filter</td>
<td>5-26</td>
</tr>
<tr>
<td>Changing the Chemical Filter (DPX2000)</td>
<td>5-27</td>
</tr>
<tr>
<td>Changing the Chemical Pad (DPX2000)</td>
<td>5-27</td>
</tr>
</tbody>
</table>
CHECKING FANS AND AIR VENTS

WARNING: Before undertaking any work on the laser marking system, remove the mains power plug.

The fans are located at the sides of the control unit and on the laser head. A fan defect immediately poses a danger of overheating that may result in damage to the control unit and laser head, therefore the fans must be checked once a month.

Control Unit and Laser Head Fans

(1) Check the fans for bearing noises. If bearing noises exist, the respective fan must be replaced.

(2) Check the fan filters of the controller (2 on the left side and 2 on the right side) for blockages and dirt. If necessary exchange them. This may be easily done from the outside without opening the controller.

Laser Head Air Vents

CAUTION: Do not use a water hose to clean the air vents.

(1) The air vents must be regularly checked for dirt and cleaned when necessary.

CLEANING THE LENS

WARNING: Ensure the mains power plug is removed before cleaning the lens.

CAUTIONS:

(1) Do not use compressed air from the installation for cleaning.

(2) Water must not be used for cleaning, as the lenses are not water resistant.

(3) Clean carefully as there is a risk of scratch marks on the lens which will reduce the marking quality.

The lens must be checked monthly for dust, and if necessary be cleaned with (absolutely clean) compressed air from a can.

For all other dirt, the lens must be cleaned with Isopropyl Alcohol and lens paper, or cotton swabs (Q-tips), as follows:

(1) Take an unused cotton swab (Q-tip) and soak one end in Isopropyl Alcohol.

(2) Lightly wipe with ONE PASS ONLY across the surface of the lens.
(3) Inspect the cotton swab. If dirt or oil is present, repeat steps (1) to (3).
(4) Use the dry end of the cotton swab to lightly wipe excess liquid from the lens.

GENERAL CLEANING

⚠️ WARNING: The laser marking system and the connected installation must be switched off with the mains supply to the laser marking system disconnected.

The outer surfaces may be cleaned with a damp cloth and a mild cleaning agent only. No humidity must get into the system.

FAULT FINDING

It can be assumed that the D-Series laser systems should require no service when properly operated. However, should there ever be a fault, service employees of Domino are at your service. For service assistance please visit the following website http://www.domino-printing.com and use the Global Map to search for local technical support.
STATUS MESSAGES AND SUGGESTED ACTIONS

The D-Series will display messages in the control unit display. The messages are listed in the following tables with actions where appropriate:

System Status Messages

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Cause</th>
<th>Suggested Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 No communication with DSP.</td>
<td>No response from the DSP part of the control system during running.</td>
<td>Turn off the controller. Check boards are all connected, restore backup, restart the controller.</td>
</tr>
<tr>
<td>2 Failed to start controller system.</td>
<td>DSP Initialisation failed.</td>
<td>Turn off the controller. Check boards are all connected, restore backup, restart the controller.</td>
</tr>
<tr>
<td>3 DSP watchdog fault.</td>
<td>The SBC did not respond to a DSP request.</td>
<td>Turn off the controller. Check boards are all connected, restore backup, restart the controller.</td>
</tr>
<tr>
<td>4 Laser watchdog fault</td>
<td>The laser has been firing for longer than expected.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>5 Print go while printing.</td>
<td>A print go trigger has been received while the laser is busy printing.</td>
<td>Check that the print go signal does not have switch bounce, check the time taken to print vs the print repeat time.</td>
</tr>
<tr>
<td>6 Encoder loop: Period too small.</td>
<td>Encoder based continuous printing feature generates the next print while the previous print is not finished.</td>
<td>Reduce the print distance or reduce width of the message.</td>
</tr>
<tr>
<td>7 Print go while DSP data not ready.</td>
<td>There is no valid data in the DSP when a print go is received.</td>
<td>Make sure the printer is ready before generating a print go. Switch off 'Force Recompile' after print.</td>
</tr>
<tr>
<td>8 Print go while DSP data not ready.</td>
<td>A new print is currently being compiled and no print start can be issued until the printer is ready again.</td>
<td>Monitor 'compile OK' line high when data compiled and make sure that you don't trigger a print before it is high again after a data change.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>10 DSP list buffer empty.</td>
<td>There is no data available for the next print.</td>
<td>Coding file is at the last item, or data from external controller is late.</td>
</tr>
<tr>
<td>11 Encoder/Line too fast (overflow).</td>
<td>The message has not been completed in time.</td>
<td>Slow down the conveyor, reduce the mark time, or move the text upstream on the field.</td>
</tr>
<tr>
<td>12 Encoder/Line too slow (underflow.)</td>
<td>The message has not been completed in time.</td>
<td>Reduce the mark time or move the text upstream on the field.</td>
</tr>
<tr>
<td>13 List buffer repeat count fail.</td>
<td>Internal Fault.</td>
<td>Restart the system, re-store backup. Contact Domino.</td>
</tr>
<tr>
<td>14 Maximum print to print distance exceeded.</td>
<td>The maximum distance between print go signals has been exceeded and an expected print go was not received.</td>
<td>Check the sensor is set up correctly, disable this function if the check is not needed.</td>
</tr>
<tr>
<td>15 Print start signal ignored.</td>
<td>A print go has been received too soon after the previous.</td>
<td>Check for switch bounce on the print go, check for a correctly set up sensor.</td>
</tr>
<tr>
<td>16 Maximum laser on time exceed (laser disabled by hardware).</td>
<td>The laser has been firing for longer than expected.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>17 Laser warm up.</td>
<td>The laser needs a short warm up period before it can be used.</td>
<td>Wait until this warning goes off before using the laser.</td>
</tr>
<tr>
<td>30 Scanhead power missing.</td>
<td>There is no +/-15v at the scanhead, or no data returning from scanhead.</td>
<td>Check connections to the print head.</td>
</tr>
<tr>
<td>31 Scanhead temperature out of valid range.</td>
<td>The scanhead is cold.</td>
<td>Wait for the heaters in the scanner motors to warm the scanners, the printer can be used but you may experience very minor position errors.</td>
</tr>
<tr>
<td>32 Scanhead warming up - please wait.</td>
<td>The scanhead is cold.</td>
<td>Wait for the heaters in the scanner motors to warm the scanners, the printer can be used but you may experience very minor position errors.</td>
</tr>
<tr>
<td>33 Control unit over temperature.</td>
<td>The temperature in the controller is very cold or too hot.</td>
<td>Check that the fans are working and that the filters are not blocked.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Laser cooling defective</td>
<td>All systems but not 30W laser: Wrong frequency from fans/water turbine was detected in the laser head. In case of 30W laser the laser tube detected a supply voltage out of range.</td>
<td>Check all fans or water turbines are connected and working. In case of 30W system check that the controller contains a 30V power supply. Check the path laser tube - V30 interface board (there LED V4 as error indicator) - up to the controller.</td>
</tr>
<tr>
<td>Control unit near over temperature</td>
<td>The controller is getting quite hot.</td>
<td>Check that the fans are working and that the filters are not blocked.</td>
</tr>
<tr>
<td>Printer ready to print</td>
<td>The printer is ready to print if a print go signal arrives.</td>
<td>Information Only.</td>
</tr>
<tr>
<td>No Message loaded</td>
<td>There is no valid message loaded into the controller.</td>
<td>Load a message and send it to printer.</td>
</tr>
<tr>
<td>Turn keyswitch to enable marking</td>
<td>The safety relay needs to be set after an interlock has been opened.</td>
<td>Turn the keyswitch to the start position, or give a remote start input (the “Play” button on the user interface will not function).</td>
</tr>
<tr>
<td>System disabled</td>
<td>The keyswitch is at position 0.</td>
<td>Turn the keyswitch to position 1.</td>
</tr>
<tr>
<td>Aiming turned on</td>
<td>The aiming beam that can be configured in the global settings is turned on (this is just informal - no fault!).</td>
<td>Information Only.</td>
</tr>
<tr>
<td>External Interlocks Open</td>
<td>The interlock or interlocks are open.</td>
<td>Close the guards to ‘make’ the interlocks.</td>
</tr>
<tr>
<td>External Interlock 1 Open</td>
<td>The interlock switch 1 is open</td>
<td>Close the guards to ‘make’ the interlocks.</td>
</tr>
<tr>
<td>External Interlock 2 Open</td>
<td>The interlock switch 2 is open</td>
<td>Close the guards to ‘make’ the interlocks.</td>
</tr>
<tr>
<td>Air Fault</td>
<td>Not enough air flow to cool the laser.</td>
<td>Check the air regulator filters and pressure settings.</td>
</tr>
<tr>
<td>Vacuum Fault</td>
<td>The DPX is not running.</td>
<td>Make sure the DPX is serviceable and running.</td>
</tr>
<tr>
<td>Filter not ok</td>
<td>The DPX filters are blocked.</td>
<td>Change the DPX filters.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chiller not ok</td>
<td>There is a problem with the chiller.</td>
<td>Check the operation of the chiller.</td>
</tr>
<tr>
<td>Chiller water level low</td>
<td>The chiller needs more water.</td>
<td>Fill the chiller.</td>
</tr>
<tr>
<td>Laser defective or over-temperature</td>
<td>The laser tube is hot, or has a bad DC supply, or does not fire.</td>
<td>Check the laser cooling and check the connections to the head.</td>
</tr>
<tr>
<td>Laser power not disabled</td>
<td>The mains to the safety relay could not be switched off.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>Laser DC power missing</td>
<td>Laser DC supply feedback from the laser head</td>
<td>Check the output from the laser PSU, check if at least one LED at the print head is on when marking is enabled. Check the analog laser voltage in the user interface diagnostics screen. Check the connection to the print head. Change the print head. Check if the installation setup has been changed.</td>
</tr>
<tr>
<td>Short AC failure (brown out)</td>
<td>The mains power dropped out for a few cycles.</td>
<td>Check the mains supply and connections to the mains.</td>
</tr>
<tr>
<td>TRIAC shorted</td>
<td>The safety circuit triac or the by-pass relay is short circuit</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>TRIAC not working</td>
<td>The safety circuit triac is open circuit so mains power cannot be applied to the safety relay.</td>
<td>Contact Domino. The unit is working in a fail-safe mode now.</td>
</tr>
<tr>
<td>Bypass relay not working</td>
<td>There is no AC mains after the By-Pass relay.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>Laser Cooling Fault</td>
<td>Wrong frequency from fans/water turbines to DSP.</td>
<td>Check all fans or water turbines are connected and working.</td>
</tr>
<tr>
<td>External 12/24V missing</td>
<td>The 12/24V interface power is missing.</td>
<td>Check PSU and connections, disconnect external devices.</td>
</tr>
<tr>
<td>Extension 24V Supply missing</td>
<td>The 24V supply is missing in the controller.</td>
<td>Look for a short circuit or other problem in the extension power supply.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>575 Safety Relay Fault</td>
<td>The safety relay did not close when reset. Furthermore if ONLY one of two</td>
<td>Open BOTH circuits to reset this state. The malfunction may be caused not only by</td>
</tr>
<tr>
<td></td>
<td>two interlocks was opened and closed again and then a laser start</td>
<td>a broken safety relay but also by malfunction of the D550+ power extension box i.e.</td>
</tr>
<tr>
<td></td>
<td>command was set, this status is shown as the safety relay MUST fail.</td>
<td>its safety-power contactors, or missing the control interconnection cable.</td>
</tr>
<tr>
<td>576 Positive scanner power</td>
<td>The +15V scanner supply is missing in the cabinet.</td>
<td>Check the power supply rails on test points and on the user interface diagnostics.</td>
</tr>
<tr>
<td>missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>577 Negative scanner power</td>
<td>The -15V scanner supply is missing in the cabinet.</td>
<td>Check the power supply rails on test points and on the user interface diagnostics.</td>
</tr>
<tr>
<td>missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>578 System Standby</td>
<td>The keyswitch is at position 1 but not yet set by turning the</td>
<td>Turn the keyswitch to start position, or give a remote start input, or press the</td>
</tr>
<tr>
<td></td>
<td>keyswitch or remote start.</td>
<td>“Start” button on the user interface.</td>
</tr>
<tr>
<td>579 Printer enabling..</td>
<td>The laser is switched on but warming up.</td>
<td>Wait for the printer to be ready.</td>
</tr>
<tr>
<td>580 Inconsistent Laser On</td>
<td>The laser start input level is being overridden by a user interface</td>
<td>In “Install Options” the option “Laser On level sensitive (hardware)” has been</td>
</tr>
<tr>
<td>State</td>
<td>laser on selection or by a fault message.</td>
<td>selected. This means that if the external laser start input is set to high the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>printer enables or is enabled, if the input is set to low the printer is not</td>
</tr>
<tr>
<td></td>
<td></td>
<td>enabled. However due to fault conditions or manual user interaction the input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>status can differ from the mark enable status - in that case this warning is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>displayed and the ‘external laser start’ signal should be set to low.</td>
</tr>
<tr>
<td>581 Next controller not ready</td>
<td>The next controller in a “chain” in a Multihead configuration is not</td>
<td>Check readiness of the next controller down the “chain”.</td>
</tr>
<tr>
<td></td>
<td>ready.</td>
<td></td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>582 Controller Idle (Multi Head System)</td>
<td>The system is part of a multi head “chain” but has been disabled (see install options). This is for information only.</td>
<td>If this controller needs to work enable it in the install options of the user interface.</td>
</tr>
<tr>
<td>583 External Interlock has been opened</td>
<td>One or both interlocks was opened but is now closed.</td>
<td>If the guards were not opened check for a bad connection on the interlock.</td>
</tr>
<tr>
<td>594 Safety Relay Fault</td>
<td>There was a laser start command present while one or both (CAT3/4) interlocks where not closed.</td>
<td>Make sure the interlocks are closed before giving the laser start input.</td>
</tr>
<tr>
<td>600 Irregular Laser Off Procedure</td>
<td>The laser did not stop when the DSP expected it to.</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>601 Laser Off Delay Ends During Laser On Delay</td>
<td>Laser parameter misconfiguration in message.</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>602 Laser Off Delay Retriggered</td>
<td>Laser parameter misconfiguration in message.</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>603 Laser On Delay Retriggered</td>
<td>Laser parameter misconfiguration in message.</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>604 I2C Sensor Bus Fault</td>
<td>Hardware malfunction</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>605 I2C Feature Bus Fault</td>
<td>Hardware malfunction</td>
<td>Contact Domino</td>
</tr>
<tr>
<td>606 Marking Controller - Transfer CRC Fault</td>
<td>Marking Controller malfunction</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>607 Marking Controller - List CRC Fault</td>
<td>Marking Controller malfunction</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>1000 Non volatile storage plugin failed to load.</td>
<td>Internal fault in software installation.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>1001 Non volatile storage not connected.</td>
<td>Wrong system setup or hardware not working.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>1002 Non volatile</td>
<td>Hardware fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>1003 Non volatile</td>
<td>Software version is incompatible with</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>storage format too old.</td>
<td>hardware version.</td>
<td></td>
</tr>
<tr>
<td>1004 Non volatile</td>
<td>Software version is incompatible with</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>storage format too new.</td>
<td>hardware version.</td>
<td></td>
</tr>
<tr>
<td>1005 Non volatile</td>
<td>Too many dynamic text contents like</td>
<td>Reduce number of counters and text inserts and then</td>
</tr>
<tr>
<td>storage capacity</td>
<td>counters, text inserts and codes used in</td>
<td>try again. If unresolved contact Domino.</td>
</tr>
<tr>
<td>exceeded.</td>
<td>the message.</td>
<td></td>
</tr>
<tr>
<td>2000 Backup file(s)</td>
<td>Inconsistency between the CF-card contents</td>
<td>This message is informational only and should not</td>
</tr>
<tr>
<td>NVMEM present.</td>
<td>and the contents on the non volatile RAM of</td>
<td>appear again after powering up the machine the next</td>
</tr>
<tr>
<td></td>
<td>the main board.</td>
<td>time. If it reappears contact Domino.</td>
</tr>
<tr>
<td>2001 Backup file(s) for</td>
<td>Inconsistency between the CF-card contents</td>
<td>This message is informational only and should not</td>
</tr>
<tr>
<td>marking engine runtime</td>
<td>and the contents on the non volatile RAM of</td>
<td>appear again after powering up the machine the next</td>
</tr>
<tr>
<td>data present.</td>
<td>the main board.</td>
<td>time. If it reappears contact Domino.</td>
</tr>
<tr>
<td>2002 Backup file(s) for</td>
<td>Inconsistency between the CF-card contents</td>
<td>This message is informational only and should not</td>
</tr>
<tr>
<td>file coding runtime</td>
<td>and the contents on the non volatile RAM of</td>
<td>appear again after powering up the machine the next</td>
</tr>
<tr>
<td>data present.</td>
<td>the main board.</td>
<td>time. If it reappears please contact Domino.</td>
</tr>
<tr>
<td>2003 Backup file(s) for</td>
<td>Inconsistency between the CF-card contents</td>
<td>This message is informational only and should not</td>
</tr>
<tr>
<td>text conversion runtime</td>
<td>and the contents on the non volatile RAM of</td>
<td>appear again after powering up the machine the next</td>
</tr>
<tr>
<td>data present.</td>
<td>the main board.</td>
<td>time - just make sure that all counters/inserts have</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the correct values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If it reappears please contact Domino.</td>
</tr>
<tr>
<td>2031 Application</td>
<td>The change in the system settings can only</td>
<td>Restart the controller.</td>
</tr>
<tr>
<td>restart required.</td>
<td>be applied by turning the Controller off and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ON.</td>
<td></td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Internal compile-error (software-bug)</td>
<td>Internal software verification has failed.</td>
<td>Please check if all message parameters are correctly set - if yes please contact Domino.</td>
</tr>
<tr>
<td>Cannot mark empty message</td>
<td>The system is configured not to accept an empty message to be marked, and an empty message has been loaded.</td>
<td>Use a message with data in it. Put data in the current message or allow empty messages. Please check if user input conditions or similar can cause this problem.</td>
</tr>
<tr>
<td>Compile-error</td>
<td>Internal software verification has failed.</td>
<td>Please check if all message parameters are correctly set - if yes please contact Domino.</td>
</tr>
<tr>
<td>Transformation failed/object out of bounds.</td>
<td>Objects or parts of objects are located outside of the usable marking field.</td>
<td>Position objects correctly.</td>
</tr>
<tr>
<td>Incomplete object, lacking external references.</td>
<td>An object references an external resource that is currently not available.</td>
<td>This normally happens if a text object references a font that does not exist in the system. Change the used font.</td>
</tr>
<tr>
<td>Missing marking parameters.</td>
<td>Parameter set of object has not been set.</td>
<td>Ensure that a parameter set is chosen for all objects.</td>
</tr>
<tr>
<td>Invalid marking parameters.</td>
<td>The values of a parameter set used by the current project are invalid.</td>
<td>Ensure a valid parameter set is chosen for all objects.</td>
</tr>
<tr>
<td>Wrong encoder direction.</td>
<td>This fault appears if a message is triggered to print in continuous mark mode while the encoder rotates in the wrong direction.</td>
<td>Check rotating direction of encoder.</td>
</tr>
<tr>
<td>Encoder too fast.</td>
<td>This fault appears if a message is triggered to print in continuous mark mode while the encoder rotates too fast.</td>
<td>Ensure the encoder never runs faster than the project can be marked. Adjust encoder speed.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>3176 Object has invalid attributes.</td>
<td>Object may reference another text/barcode object that does not exist or uses a dynamic text tag that is undefined. This fault can also appear if you try to cross-link multiple text-objects.</td>
<td>Check for invalid attributes.</td>
</tr>
<tr>
<td>3177 Failed to compile referenced object.</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3178 List overflow: project too large.</td>
<td>The number of vectors for marking the project is too high.</td>
<td>Reduce the number of vectors by reducing resolutions or increasing the maximum vector length etc.</td>
</tr>
<tr>
<td>3179 Mark limit reached.</td>
<td>The predefined limit of marks has been reached</td>
<td>This message is displayed when you print from a file and the end of the file has been reached or if you have counters enabled that have “Disable Marking” configured if they reach their end value.</td>
</tr>
<tr>
<td>3180 Print failed.</td>
<td>General fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3181 DSP failure.</td>
<td>The DSP hardware cannot be contacted for transferring vectors.</td>
<td>Ensure that the boards are fitted correctly.</td>
</tr>
<tr>
<td>3182 Print timeout.</td>
<td>The current print has lasted longer than the timeout for a print as defined in the system setup.</td>
<td>Increase the timeout value or turn the timeout off by setting the value to 0.</td>
</tr>
<tr>
<td>3183 Missing “printstart” parameter set</td>
<td>The usage of the “printstart” parameter set for the first polygon in the print has to be selected.</td>
<td>Define a parameter set with this name or uncheck this option.</td>
</tr>
<tr>
<td>3184 Barcode Error Wrong code length.</td>
<td>The barcode type needs a specific length of input data.</td>
<td>Change input data or code type.</td>
</tr>
<tr>
<td>3185 Barcode Error Unrecognised code type.</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3186 Barcode Error</td>
<td>The barcode cannot be calculated with the parameters given.</td>
<td>Check the barcode-specific parameters.</td>
</tr>
<tr>
<td>3187 Barcode Error</td>
<td>The barcode data contains at least one character that is not allowed for this code type.</td>
<td>Check characters in barcode.</td>
</tr>
<tr>
<td>3188 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3189 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3190 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3191 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3192 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3193 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3194 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3195 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3196 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3197 Barcode Error</td>
<td>General software fault.</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>3198 Barcode Error</td>
<td>There was a fault calculating the check sum.</td>
<td>Ensure that the correct algorithm for generating the check sum has been selected.</td>
</tr>
<tr>
<td>3199 to 3201 Barcode Error</td>
<td>Some parameters of the MRC are not valid.</td>
<td>Check the MRC parameters.</td>
</tr>
<tr>
<td>3202 Barcode Error</td>
<td>The selected MRC is not supported.</td>
<td>Check the MRC parameters.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3203</td>
<td>Barcode Error! Code-Creation failed</td>
<td>Check the text is valid for this MRC type.</td>
</tr>
<tr>
<td>3204 to 3206</td>
<td>Barcode Error! Pattern-Creation failed</td>
<td>Check the text is valid for this MRC type.</td>
</tr>
<tr>
<td>3208</td>
<td>Barcode Error! RSS Fault</td>
<td>Check the GS1 DataBar options used.</td>
</tr>
<tr>
<td>3209</td>
<td>Barcode rendering mode not supported</td>
<td>Check the Rendering options.</td>
</tr>
<tr>
<td>3210</td>
<td>Invalid file path</td>
<td>Check the file exists in the right place.</td>
</tr>
<tr>
<td>3211</td>
<td>Failed to load file</td>
<td>Check the file exists in the right place.</td>
</tr>
<tr>
<td>3212</td>
<td>File too big</td>
<td>Reduce the file size.</td>
</tr>
<tr>
<td>3213</td>
<td>Bitmap format unknown</td>
<td>Dynamark 3 currently only supports bitmaps in uncompressed monochrome Windows BMP format.</td>
</tr>
<tr>
<td>3214</td>
<td>Bitmap not monochrome</td>
<td>Dynamark 3 currently only supports bitmaps in uncompressed monochrome Windows BMP format.</td>
</tr>
<tr>
<td>3215</td>
<td>Bitmap is compressed</td>
<td>Dynamark 3 currently only supports bitmaps in uncompressed monochrome Windows BMP format.</td>
</tr>
<tr>
<td>3216</td>
<td>Unknown HPGL code</td>
<td>Make sure that a supported version of the HPGL file format is used.</td>
</tr>
<tr>
<td>3217</td>
<td>No Message</td>
<td>Select a message and send it to printer.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>------------------</td>
</tr>
<tr>
<td>3218 Invalid condition</td>
<td>The mark enable condition (digital input mask/digital input value) in the object properties are not set properly.</td>
<td>The mark enable condition (digital input mask/digital input value) in the object properties are not set properly (e.g. the value uses input channels that have not been defined in the mask).</td>
</tr>
<tr>
<td>3219 Codepoint out of range</td>
<td>A Unicode character has been referenced that is out of the valid range.</td>
<td>Check the Unicode number of the character required - Dynamark 3 only supports Unicode character codes up to 65535.</td>
</tr>
<tr>
<td>3220 Unknown text format specifier</td>
<td>The dynamic text format specifier (e.g. &lt;CLK_YY:x&gt; for year) is unknown.</td>
<td>Check if invalid specifiers have been used or the message has been set up with an incompatible software version.</td>
</tr>
<tr>
<td>3221 Text reference not found</td>
<td>A text link points to another text or MRC object that does not exist.</td>
<td>Check if an object that is referenced by another one has been deleted. Re-edit the referencing objects to point to other existing objects or remove the link.</td>
</tr>
<tr>
<td>3222 Invalid text format specifier</td>
<td>The syntax of a dynamic text format specifier (e.g. &lt;CLK_YY:x&gt; for year) is invalid.</td>
<td>Check if the message has been set up with an incompatible software version.</td>
</tr>
<tr>
<td>3223 Isolated accent in text</td>
<td>A character with width=0 (typically an accent that shall be put upon the character following) is not followed by another character.</td>
<td>Check if there is an accent character at the end of a line/message or if the last character in a line has an invalid width setting in its font definition (e.g. by changing the font).</td>
</tr>
<tr>
<td>3224 Invalid Setup</td>
<td>The system setup is inconsistent (some settings don’t fit to others).</td>
<td>Check message setup, create a new message.</td>
</tr>
<tr>
<td>3225 Batch finished</td>
<td>A batch (e.g. coding from a file) has been finished printing.</td>
<td>Load another coding file or set the line number within the coding file to a valid line within the file and then re-enable marking.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3226 Referenced glyph not found in font</td>
<td>The character that is referenced by the message of a text object does not exist in the font that is used.</td>
<td>Change marking font.</td>
</tr>
<tr>
<td>3227 Marking disabled by counter</td>
<td>A counter ending action has disabled printing.</td>
<td>Marking has been disabled as this counter has now reached its end value. Attention: even counters that are not used within the message but globally active can disable marking!</td>
</tr>
<tr>
<td>3228 Font not installed</td>
<td>The font referenced by the text object is not installed in the system.</td>
<td>Install the font, use a different font.</td>
</tr>
<tr>
<td>3229 Font too large</td>
<td>The font file is too large to fit into the printer controller’s memory.</td>
<td>Use another font or minimize the amount of different fonts used within the message.</td>
</tr>
<tr>
<td>3230 Corrupt font file</td>
<td>The font file could not be loaded as it has been identified as corrupt.</td>
<td>Replace the font file, use a different font.</td>
</tr>
<tr>
<td>3231 PN transformation - invalid parameters!</td>
<td>The parameters for the PN transformation are not valid.</td>
<td>Check the PN setup, try automatic setup.</td>
</tr>
<tr>
<td>4000 and 4001 Security Dongle missing - System locked</td>
<td>The system is locked due to the fact that the advanced or remote security mode has been enabled and no security dongle is fitted to the laser controller - only a service user can now log into the system.</td>
<td>Insert the Security Dongle into the controller as the pharma option has been activated; in case the pharma option is not active by intention please contact the Domino to deactivate it.</td>
</tr>
<tr>
<td>4002 Service Dongle active</td>
<td>A service user has logged in to the system by use of a service dongle.</td>
<td>Informal message only.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Cause</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>------------------</td>
</tr>
<tr>
<td>4003 Remote Security Server not accessible</td>
<td>The system has been set up to use a remote server to authenticate users - however this server cannot be accessed via network.</td>
<td>Check network setup or wiring. Only the local service login is possible.</td>
</tr>
<tr>
<td>4004 Audit Trail Backup needed</td>
<td>Some audit trail entries are older than the specified limit in the Dynamark 3 service menu - this is to remind the operator to export the audit trail data from the action log menu. (Pharma option only)</td>
<td>Export the audit trail data from the action log menu.</td>
</tr>
<tr>
<td>4005 Audit Trail Backup needed - System disabled</td>
<td>Some audit trail entries are older than the specified limit in the Dynamark 3 service menu - the system will not continue to print until the operator has exported the audit trail data from the action log menu. (Pharma option only!)</td>
<td>Export the audit trail data from the action log menu.</td>
</tr>
<tr>
<td>4006 Dongle expired</td>
<td>The service dongle has expired (some dongles have a limited life time in order to prohibit illegal usage).</td>
<td>Contact Domino.</td>
</tr>
<tr>
<td>4007 Dongle is about to expire</td>
<td>The service dongle is about to expire (some dongles have a limited life time in order to prohibit illegal usage).</td>
<td>Contact Domino.</td>
</tr>
</tbody>
</table>
REPLACING THE LENS

WARNINGS:  
(1) Before undertaking any work on the laser marking system, remove the mains power plug.
(2) This procedure is to be performed by fully trained engineers only.
(3) The lens must not come in contact with unprotected skin (health hazard).

CAUTION: Protect the lens from damage by shock or scratching.

The lens consists of the optics retainer and the focusing lens, which has been adjusted at manufacture.

Notes:  
(1) Ensure the replacement lens is available before starting this procedure.
(2) In addition to its primary optical purpose, the objective, with its built-in lens, simultaneously acts as protection from dust and alike for the beam scanning unit. As a result, the lens should not be removed for any longer than necessary.
(3) To exchange the lens fit the lens cover to the lens. The cover is delivered with every system.
(4) Release these two screws and pull out the lens cover together with the lens. The lens is then held by 2-O-rings and no screws.
(5) To mount a lens, plug in the lens together with the lens cover and fasten the two screws.
CHANGING THE FUSES

WARNINGS: (1) Before undertaking any work on the laser marking system, remove the mains power plug.
(2) This procedure is to be performed by fully trained engineers only.
(3) Two pole fuses are used.

Main Power Fuses F1 and F2

If a fuse is blown, replace with the same type:

- Manufacture: SIBA Sicherungen-Bau GmbH; Lunen, Germany (Distributor: Farnell 117-5150) Art.Nr. 70 065 65 - 12.5A T
- Rated Current: 12.5A delay
- Rated breaking capacity: 1500A / 500V AC

\[ T 1 2, 5 H 5 0 0 V \]

Laser Power Supply Fuse, Label F3

If a fuse is blown replace with the same type

- Rated Current 10A fast.
- Rated breaking capacity: 750A / 250V AC.

\[ F 1 0 E 2 5 0 V \]
CHANGING THE PC-CMOS SETUP
BATTERY

WARNINGS:  (1) Before undertaking any work on the laser marking system, remove the mains power plug.
(2) This procedure is to be performed by fully trained engineers only.
(3) There is danger of the battery exploding if replaced incorrectly, so follow this procedure.

The battery has to be exchanged every 3 to 5 years, depending on the operating time of the controller.

Open the controller drawer and pull the electronics out.

The battery BT1 is located on the ETX base board. Use a screwdriver to remove the old battery. Be extremely careful not to damage other parts on the ETX base board.

Battery type is:
• Panasonic Type: CR2032/BE 3V / 180mAh (or equivalent)

There is the danger of explosion if the battery is replaced incorrectly, please ensure the correct polarity is observed when replacing the battery.

Dispose of the old battery.

HIGH VOLTAGE DURING MAINTENANCE

High voltage is still present when the controller is switched off at the following locations:
• Main connector Harting HanQ
• EMC filter Schaffner
• Fuses F1 and F2
• Main switch push button.

All locations are marked with the sign for high voltage.
STATUS LEDS

Inside the controller, some LEDs display the status of the electronics.

On the DIB board directly on the front:

<table>
<thead>
<tr>
<th>Name</th>
<th>Colour</th>
<th>Location</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>V6</td>
<td>green</td>
<td>DIB-PCB</td>
<td>Product Detect</td>
</tr>
<tr>
<td>V7</td>
<td>green</td>
<td>DIB</td>
<td>Mark suppress Control</td>
</tr>
<tr>
<td>V8</td>
<td>green</td>
<td>DIB</td>
<td>Encoder Channel A</td>
</tr>
<tr>
<td>V9</td>
<td>green</td>
<td>DIB</td>
<td>Laser Fan Frequency</td>
</tr>
<tr>
<td>V10</td>
<td>yellow</td>
<td>DIB</td>
<td>Laser Modulation</td>
</tr>
<tr>
<td>V11</td>
<td>red</td>
<td>DIB</td>
<td>Laser Error</td>
</tr>
<tr>
<td>V12</td>
<td>yellow</td>
<td>DIB</td>
<td>Bypass Relay Power Supply</td>
</tr>
<tr>
<td>V13</td>
<td>green</td>
<td>DIB</td>
<td>Encoder Channel B</td>
</tr>
<tr>
<td>V14</td>
<td>yellow</td>
<td>DIB</td>
<td>Mains Wave pos. AC</td>
</tr>
<tr>
<td>V15</td>
<td>yellow</td>
<td>DIB</td>
<td>Mains Wave neg. AC</td>
</tr>
<tr>
<td>V16</td>
<td>green</td>
<td>DIB</td>
<td>Ready Chain FB</td>
</tr>
<tr>
<td>V17</td>
<td>orange</td>
<td>DIB</td>
<td>Key Switch position “Laser start”</td>
</tr>
</tbody>
</table>

On the safety relay:

<table>
<thead>
<tr>
<th>Name</th>
<th>Colour</th>
<th>Location</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED Power</td>
<td>green</td>
<td>Safety Relay</td>
<td>Supply voltage</td>
</tr>
<tr>
<td>LED In1</td>
<td>green</td>
<td>Safety Relay</td>
<td>Input status, channel 1</td>
</tr>
<tr>
<td>LED In2</td>
<td>green</td>
<td>Safety Relay</td>
<td>Input status, channel 2</td>
</tr>
<tr>
<td>LED Out</td>
<td>green</td>
<td>Safety Relay</td>
<td>Switch status, safety contacts</td>
</tr>
<tr>
<td>LED Reset</td>
<td>green</td>
<td>Safety Relay</td>
<td>Reset circuit</td>
</tr>
<tr>
<td>LED Fault</td>
<td>red</td>
<td>Safety Relay</td>
<td>Error</td>
</tr>
</tbody>
</table>

On the ETX base board:

<table>
<thead>
<tr>
<th>Name</th>
<th>Colour</th>
<th>Location</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>FPGA Hardware-Design loaded</td>
</tr>
<tr>
<td>V2</td>
<td>yellow</td>
<td>ETXB-PCB</td>
<td>HDD Activity</td>
</tr>
<tr>
<td>V3</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>5V present</td>
</tr>
<tr>
<td>V4</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>3.3V present</td>
</tr>
<tr>
<td>V5</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>2.5V present</td>
</tr>
<tr>
<td>V6</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>1.26V present</td>
</tr>
<tr>
<td>V7</td>
<td>red</td>
<td>ETXB-PCB</td>
<td>ETH 1 Link</td>
</tr>
<tr>
<td>V8</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>ETH 1 Speed (10/100 MBit)</td>
</tr>
<tr>
<td>V9</td>
<td>yellow</td>
<td>ETXB-PCB</td>
<td>ETH 1 Activity</td>
</tr>
<tr>
<td>V10</td>
<td>yellow</td>
<td>ETXB-PCB</td>
<td>ETH 2 Link</td>
</tr>
<tr>
<td>V11</td>
<td>red</td>
<td>ETXB-PCB</td>
<td>ETH 2 Speed (10/100 MBit)</td>
</tr>
<tr>
<td>V12</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>ETH 2 Activity</td>
</tr>
<tr>
<td>V13</td>
<td>green</td>
<td>ETXB-PCB</td>
<td>DSP application loaded</td>
</tr>
</tbody>
</table>
WATER CHILLER

- Check all hoses for blocking or holes on a regularly monthly basis.
- Never store the chiller without coolant.
- Exchange the coolant at least every two years.
- See the water chiller manual for the procedure to exchange the coolant. (See Part 1 for safety guidelines).
- Avoid skin contact with the coolant. Always wear protective gloves and safety goggles when working with the coolant.
- Coolant may be ordered from Domino.

TOUCHPANEL BUFFER BATTERY

This work should only be done by trained technicians.

An empty buffer battery is displayed by the error message

- 0271: Check data and time settings. Press <F1> to resume, <F2> to Setup

The TouchPanel stops booting and the date is set to “01/01/2010” and time to “00:00”.

To replace the buffer battery:

- Disconnect the TouchPanel from power (external power and power via X59 ethernet connection)
- Disconnect all cables and USB devices from the TouchPanel
- Dismount the TouchPanel out of the brackets and lay it with the front side (touch screen) on a flat and soft surface to prevent damages to the touch screen
- Remove all screws from the rear of the TouchPanel
- Open the TouchPanel carefully
- Locate the buffer battery
MAINTENANCE AND FAULT FINDING

- Take out the battery and dispose it correctly and environmentally responsibly.

CAUTIONS:  
(1) Incorrect handling may lead to explosions! 
(2) Only use a battery of the same type to replace the buffer battery! Battery type: “Lithium Manganese Dioxide Battery CR2032” from Maxell, 3V / 220mAh 
(3) Ensure correct polarity and fitting of the new battery!

- Re-assemble the TouchPanel in reverse order.
FUME EXTRACTION SYSTEM

WARNINGS:  
(1) Only use genuine Domino replacement parts. Any other parts may not meet the design or working requirements and put personnel at risk.  
(2) Opening the cabinet door while the extraction system is in operation will stop the extraction process (see procedure below).  
(3) Full protective clothing must be worn when changing bags, filters and pads. Use the filter change kits provided with each filter.  
(4) Dispose of used filters in the plastic bag provided in the filter change kit according to local regulations.

General Notes  
These notes are particular to the DPX scheduled maintenance.  
- Alarms (audible and visual): refer to the Fault Finding and Repair section  
- Instruction sheets are provided with each repair kit and not in this manual  
- The main filter and chemical filters are heavy, therefore care must be taken when removing  
- Always check the following for debris build-up when changing a filter:  
  (a) Extraction nozzle  
  (b) Flexible hose  
  (c) Air inlet  
  (d) Sense line (silicone tubing attached to the inside of the air inlet).

Recommended Routine Maintenance  
Primary maintenance is filter replacement. The fume extractor control system will indicate when this is necessary. Experience of local conditions may be used to formulate a periodic replacement schedule.

Daily  
Visually check that fumes are being drawn into the extractor.

Weekly  
Check the LCD status bars on the control panel.

Annual  
Consult Domino for advice.
Changing Filter Bags

**WARNINGS:**

(1) Full protective clothing must be worn and correct disposal methods used immediately.

(2) Filters must be changed in accordance with the instruction sheet provided with the filter kit.

*Note:* Filter alerts may be caused by debris build up in the extraction nozzle, hose, air inlet or sense line in the air inlet. Always check these areas are free from debris before changing the filter.

The filter bag is situated in the bottom compartment.

(1) Turn off the extractor.

(2) Turn the two door latches on the front of the machine 90°, then open the cabinet door.

(3) Using the filter change kit provided with each new filter, pull the Filter Bag off the air inlet, ensuring the bag inlet faces away from the operator, and remove.

(4) Bag and seal the old filter in the bag provided.

(5) Insert the new Filter Bag, pushing the entry hole in the filter over the air inlet. Ensure that the filter entry is fully pushed onto the inlet pipe.

(6) Close the cabinet door, turning the latches fully in their respective directions.

(7) *For DPX2000 only* - Replace the chemical pad that is supplied with the Super Filter bag.

Changing Main Filter

**WARNINGS:**

(1) Full protective clothing must be worn and correct disposal methods used immediately.

(2) Filters must be changed in accordance with the instruction sheet provided with the filter kit.

(1) Turn off the extractor.

(2) Open the cabinet door.

(3) Turn the filter locking handle 180° counter clockwise, so that it is horizontal and in the filter unlocked position.

**WARNING:** This filter is heavy and must be removed with care.

(4) The filter will drop slightly to allow release. Pull the main filter forward and remove completely.

(5) Bag and seal the old filter in the bag provided.

(6) Insert the new main filter into the machine ensuring that the filter label is in front and the airflow arrow is pointing up.

(7) Turn the filter locking handle 180° clockwise, so that it is horizontal and in the filter locked position.

(8) Close the cabinet door, turning the catch fully clockwise.
Changing the Chemical Filter (DPX2000)

WARNING: Full protective clothing must be worn and correct disposal methods used immediately.

(1) Turn off the extractor.
(2) Open the cabinet door.
(3) Turn the filter locking handle 180° anti-clockwise so that it is horizontal and in the filter unlocked position.

WARNING: This filter is heavy and must be removed with care.

(4) The filter will drop slightly to allow release. Pull the filter forward and remove completely.
(5) Insert the new filter into the machine ensuring that the airflow arrow is in front and the filter label is pointing up.
(6) Turn the filter locking handle 180° clockwise, so that it is horizontal and in the filter locked position.
(7) Close and lock the cabinet door, turning the catch fully clockwise.

Changing the Chemical Pad (DPX2000)

WARNING: Full protective clothing must be worn and correct disposal methods used immediately.

(1) Turn off the extractor.
(2) Open the cabinet door.
(3) Remove the Super Filter Bag.
(4) Lift the Chemical Pad out of the bottom of the compartment and dispose of using approved procedures.
(5) Place a new Chemical Pad onto the bottom of the compartment.
(6) If required, fit a new Filter Bag as on page 5-26.
(7) Close and lock the cabinet door, turning the catch fully clockwise.
APPENDIX A : MARKING FONTS

The following fonts are supported within Dynamark 3 software:

- 1LS-Arabic NC
- 1LS-Arial fast
- 1LS-Arial-Arab
- 1LS-Chinese-1
- 1LS-Chinese-2
- 1LS-DotMatrix
- 1LS-OCR-A
- 1LS-OCR-B NC
- 1LS-OCR-B-10 BT
- 1LS-PET NC
- 1LS0-Arial
- 1LS0-Arial NC
- 1LS0-Arial fast
- 2LCS-Helvetica
- 2LS-Arial
- 2LS-Arial NC
- 2LS-Folio
- 2LS-Romi
- 2RLS-Japanese
- 2RLS-Korean
- 2-RLS-Simpl.Chinese
- 2-RLS-Trad.Chinese
- 3LS-Rom
- 3LS-Romi
- 5LS-Arial
- HS-Arial strong
- HS-Arial medium
- HS-Arial light
APPENDIX B : BARCODES

CONTENTS

<table>
<thead>
<tr>
<th>BARCODE TYPES SUPPORTED</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B-3</td>
</tr>
<tr>
<td>1-D Barcodes</td>
<td>B-3</td>
</tr>
<tr>
<td>2-D Barcodes</td>
<td>B-5</td>
</tr>
</tbody>
</table>
**BARCODE TYPES SUPPORTED**

**1-D Barcodes**

In the table below, the types of 1-D barcodes supported by Dynamark 3 are summarised, with the type and number of characters specified for that barcode type. The term “any” means capital letter and number characters; in some cases additional characters are defined, but lower case letters are not permitted. Only Extended Code 39 and the EAN 128 and Code 128 codes provide symbols for the full ASCII character set.

There are many named barcode types which are actually derivatives of major types. To avoid the table becoming excessively complex, only generic names are used, e.g. ISBN, ISSN and JAN coding schemes are all variants of the EAN scheme. There are several coding schemes (such as DEFCON) which are actually Code 39, and some countries use Code 128 under other names for mail tracking (as in the UK).

<table>
<thead>
<tr>
<th>Code Type</th>
<th>No. of Characters</th>
<th>Check Digit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 of 5</td>
<td>any numbers</td>
<td></td>
</tr>
<tr>
<td>2 of 5DL</td>
<td>number pairs</td>
<td>1 optional</td>
</tr>
<tr>
<td>2 of 5 IATA</td>
<td>number pairs</td>
<td>1 optional</td>
</tr>
<tr>
<td>2 of 5 IL</td>
<td>number pairs</td>
<td>1 optional</td>
</tr>
<tr>
<td>2 of 5 IND</td>
<td>number pairs</td>
<td>1 optional</td>
</tr>
<tr>
<td>3 of 9</td>
<td>any</td>
<td></td>
</tr>
<tr>
<td>AP Reply Paid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AP Routing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AP Redirect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code11</td>
<td>any</td>
<td>1 or 2</td>
</tr>
<tr>
<td>Code39</td>
<td>Upper Case Alphanumeric</td>
<td>1 optional</td>
</tr>
<tr>
<td>Code39Ext.</td>
<td>any (full ASCII)</td>
<td>1 optional</td>
</tr>
<tr>
<td>Code93</td>
<td>any</td>
<td>2 optional</td>
</tr>
<tr>
<td>Code93 Ext.</td>
<td>any (full ASCII)</td>
<td>2 optional</td>
</tr>
<tr>
<td>Code128</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>Code128A</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>Code128B</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>Code128C</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>Codabar2</td>
<td>any</td>
<td></td>
</tr>
<tr>
<td>DP Leitzahl</td>
<td>numeric</td>
<td></td>
</tr>
<tr>
<td>DP Ident</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAN8</td>
<td>8 numbers</td>
<td>1 of the 8</td>
</tr>
<tr>
<td>EAN8+2</td>
<td>10 numbers</td>
<td>1 of the 10</td>
</tr>
<tr>
<td>EAN8+5</td>
<td>13 numbers</td>
<td>1 of the 13</td>
</tr>
<tr>
<td>Code Type</td>
<td>No. of Characters</td>
<td>Check Digit</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>EAN13</td>
<td>13 numbers</td>
<td>1 of the 13</td>
</tr>
<tr>
<td>EAN13+2</td>
<td>15 numbers</td>
<td>1 of the 15</td>
</tr>
<tr>
<td>EAN13+5</td>
<td>18 numbers</td>
<td>1 of the 18</td>
</tr>
<tr>
<td>EAN14</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>EAN128</td>
<td>any</td>
<td>automatic</td>
</tr>
<tr>
<td>ITF-6</td>
<td>6 numbers</td>
<td>1 (EAN optional)</td>
</tr>
<tr>
<td>ITF-14</td>
<td>14 numbers</td>
<td>1 (EAN optional)</td>
</tr>
<tr>
<td>LOGMARS</td>
<td>any</td>
<td></td>
</tr>
<tr>
<td>MSI</td>
<td>any numbers</td>
<td>1 or 2</td>
</tr>
<tr>
<td>NVE 18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pharma 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pharma 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plessey</td>
<td>numeric/some alpha</td>
<td>2</td>
</tr>
<tr>
<td>PostNet 5</td>
<td>5 numbers</td>
<td>no</td>
</tr>
<tr>
<td>PostNet 6</td>
<td>6 numbers</td>
<td></td>
</tr>
<tr>
<td>PostNet 8</td>
<td>8 numbers</td>
<td>no</td>
</tr>
<tr>
<td>PostNet 10</td>
<td>10 numbers</td>
<td></td>
</tr>
<tr>
<td>PostNet 11</td>
<td>11 numbers</td>
<td>no</td>
</tr>
<tr>
<td>PostNet 12</td>
<td>12 numbers</td>
<td></td>
</tr>
<tr>
<td>PZN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RM4SCC</td>
<td>4 state clocked</td>
<td>1 optional</td>
</tr>
<tr>
<td>GST DataBar</td>
<td>14 (reduced space)</td>
<td>no</td>
</tr>
<tr>
<td>SSCC 18</td>
<td>18 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UCC 128</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPG 12</td>
<td>12 numbers</td>
<td></td>
</tr>
<tr>
<td>UPCA</td>
<td>12 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UPCA+2</td>
<td>14 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UPCA+5</td>
<td>17 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UPCE</td>
<td>7 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UPCE+2</td>
<td>9 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>UPCE+5</td>
<td>12 numbers</td>
<td>1 optional</td>
</tr>
<tr>
<td>Raw BarCode</td>
<td>any</td>
<td></td>
</tr>
</tbody>
</table>
# 2-D Barcodes

The following types of 2-D codes are supported within Dynamark 3 software:

<table>
<thead>
<tr>
<th>Barcode</th>
<th>Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codablock F</td>
<td>Stacked</td>
<td>2-44 rows of 1-61 characters per row</td>
</tr>
<tr>
<td>PDF417</td>
<td>Stacked</td>
<td>Up to 1848 different patterns</td>
</tr>
<tr>
<td>PDF417 Truncated</td>
<td>Stacked</td>
<td></td>
</tr>
<tr>
<td>QR Code</td>
<td>Stacked</td>
<td>4296 Alphanumeric</td>
</tr>
<tr>
<td>Matrix 2/5</td>
<td>Matrix</td>
<td>Any numeric</td>
</tr>
<tr>
<td>Raw MatrixCode</td>
<td>Matrix</td>
<td>Any</td>
</tr>
<tr>
<td>Data Matrix</td>
<td>Matrix</td>
<td>Double digits - 3100 digits max. Alphanumeric text - 2300 characters max</td>
</tr>
<tr>
<td>Aztec</td>
<td>Matrix</td>
<td>3000 Alphanumeric</td>
</tr>
<tr>
<td>Han Xin</td>
<td>Matrix</td>
<td>Alphanumeric, Chinese characters, graphic and audio information</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximum symbol data capacities are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7827 numeric characters, 4350 ASCII characters, 2174 Common Chinese</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Characters in Region 1 or Region 2, 1739 2-byte Chinese characters data,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1044 4-byte Chinese characters, and 3261 binary byte data.</td>
</tr>
<tr>
<td>Dotcode</td>
<td>Matrix</td>
<td>6x9 up to 9x9 matrix code. Binary code of dots and empty spaces (1,0)</td>
</tr>
<tr>
<td>Micro-QR-Code</td>
<td>Matrix</td>
<td>There are 4 different versions of Micro QR codes: the smallest is 11x11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>modules; the largest can hold 35 numeric characters</td>
</tr>
</tbody>
</table>